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ВСТУП 

 

Давнім прагненням людства було створення приладів, що були б здатні полегшити 

людську  працю. Спочатку  йшлося про інструменти та машини, які механізували тільки 

фізичну  працю, але пізніше постало питання розробки "розумних машин", які функціонували 

б подібно до людського мозку . Така постановка завдання викликає наступні принципові 

питання: 

� чи є взагалі можливим створення машини, здатної до інтелектуальної діяльності; 

� чим характеризується інтелектуальність людини та на чому  вона ґрунтується; 

� які головні принципи мають лягти в основі так званого "штучного інтелекту". 

Спочатку  треба пояснити, що означає поняття "інтелектуальність" стосовно до  

людини. Інтелектуальність (розумність) у  такому  контексті можна визначити як наявність  

комплексної когнітивної здатності, за допомогою якої людина впізнає об 'єкти, явища та 

відповідно до ситуації на них реагує. Серед типових характерних рис інтелектуальності слід 

зазначити такі: 

� усвідомлення ситуації, виходячи із багатозначної або суперечливої інформації; 

� знаходження аналогій, здатність до класифікації; 

� здатність до вивчення нових понять та встановлення зв'язків між різними 

поняттями.  

Завданням теорії штучного інтелекту  як області прикладної математики є 

знаходження засобів формалізації процесів  усвідомлення та пізнавання та переніс їх на мову  

алгоритмів. При цьому  розумова діяльність постає як засіб обробки інформації. Це означає,  

що теорія штучного інтелекту  виходить з того, що діяльність людського розуму  в певній мірі 

може бути розглянута незалежно від функцій мозку , тобто достатньо знати основні 

принципи розумної поведінки, щоб записати їх у  вигляді алгоритмів, зрозумілих для 

комп'ютера. Таким чином, інженерно-науковий аспект теорії штучного інтелекту  полягає в  

проектуванні складних систем обробки інформації. Це завдання включає в себе розробку  як 

методів обробки інформації, так і відповідних пристроїв та програмного забезпечення.  

В даний час можна виділити чотири напрямки розвитку  комп'ютерного інтелекту : 

� фази-логіка; 

� експертні системи; 

� нейросітки; 

� еволюційне моделювання. 
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Перед теорією штучного інтелекту  стоїть завдання створення комп'ютерних систем,  

які були б здатні вирішувати такі задачі: 

1. вирішення проблем. Розв'язання знаходиться шляхом зведення наявної 

інформації до відомих елементарних висловлень та пошуку  в базі знань необхідної 

інформації; 

2. розпізнавання та розуміння людського мовлення; 

3. розпізнавання та обробка зображень, тобто впізнавання із візуальної інформації 

окремих об'єктів та груп об'єктів. Цей процес вимагає класифікації об'єктів за 

певними характерними ознаками; 

4. навчання. Знання має автоматично  накопичуватись з метою покращення  

властивостей системи; 

5. експертні оцінки. Специфічні для певної області знання мають бути збережені та 

оброблені комп'ютером таким чином, щоб система могла самостійно приймати 

рішення, подібно спеціалісту  з цієї галузі; 

6. якісні висновки. Ця область застосовується при аналізі процесів, які мають не 

чіткий кількісний, а якісний опис.  

Вирішення першого, четвертого та шостого завдань тісно пов'язане із фази-логікою. 

Фази-логіка використовується в інформатиці, техніці регулювання та математиці для 

моделювання експертного знання та вирішення задач автоматизації. Експертні знання при 

цьому  представляються у  формі якщо...то-правил із якісними поняттями, такими, як велика, 

маленька. Застосування такого методу  обробки інформації є доцільним при створенні систем 

регулювання для об'єктів, які описуються через велику  кількість параметрів (особливо якщо 

ці параметри змінюються за нелінійними законами) і мають досить складну  математичну  

модель. 

Слід зазначити, що фази-логіка була взята інженерами на “озброєння” ще в сімдесяті 

роки. Звичайно, що сьогодні вона не відповідає сучасним вимогам, які ставляться до систем 

програмного керування, і тому  застосування її у  “чистому  вигляді” є дуже рідкісним.  

Удосконалити фази–логіку , зробити її спроможною до адаптації в системах регулювання 

були покликані інші типи штучного інтелекту . Насамперед це нейросітки,  експертні системи 

та еволюційні методи.  

Дані методичні вказівки містять основи теорії фаззи-логіки та фаззи-регулювання, 

огляд засобів побудови на її основі фаззи-регуляторів, основних типів контурів регулювання 
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із фази-контролером. Практичному  застосуванню фази-логіки в системах автоматизації 

присвячені дві лабораторні роботи. 
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1 ОСНОВИ ТЕОРІЇ ФАЗИ-ЛОГІКИ ТА ФАЗИ-РЕГУЛЮВАННЯ 

 

1.1 Фази-множини та основні операції над ними 

 

Фази-логіка – технологія розробки систем управління, яка базується на інтуїції 

експерта. Замість чіткого математичного опису  фази-логіка використовує для опису  

поведінки системи лінгвістичні визначення (лінгвістичні змінні), значеннями яких є мовні 

конструкції, а не числові значення. Ці лінгвістичні змінні моделюються за допомогою так  

званих нечітких множин. Нечітка множина – множина, елементи якої належать до неї з тим 

чи іншим ступенем приналежності. Це означає, що кожному  елементу  цієї множини 

відповідає ступінь приналежності, що  знаходиться в інтервалі від 0% до 100%. Математично  

нечітка множина записується таким чином: 

 

A = {[x1, µA(x1)]...[xn, µA(xn)]}    (1.1) 

 

Це означає,  що величина х1  належить до нечіткої множини А із ступенем 

приналежності µA(x1). 

Елементи чіткої (класичної) множини можуть приймати тільки два значення ступеня  

приналежності – 0% та 100%. Математично чітка множина записується таким чином: 

 

A = {x1, x2...xn}      (1.2) 

 

Як правило для визначення фази-множини A замість упорядкованої пари x1, µA(x1)  

використовують так звану  функцію приналежності µA(x). Функція приналежності показує 

ступінь приналежності конкретного значення до певної нечіткої множини в області зміни 

вимірюваної величини, що підлягає розгляду . Функція приналежності може приймати 

різноманітні форми, найбільш поширені з них наведені в табл. 1.1. 

Обробка фази-множин вимагає відповідних операторів, за допомогою яких 

реалізується зв'язок та модифікація фази-множин. Ці оператори розподіляються на дві групи: 

� оператори, що пов'язують фази-множини єдиної базової множини; 

� оператори, що обробляють фази-множини окремих базових множин.  



ОСНОВИ ТЕОРІЇ ФАЗИ-ЛОГІКИ ТА ФАЗИ-РЕГУЛЮВАННЯ  8

Таблиця 1.1 – Функції приналежності 

 

Тип функції Математичне визначення Графічне зображення 

Монотонна 
(лінійна) 










≤

≤≤
−
−

<

=

xbпри1

bxaпри
ab

ax
axпри0

(x)µ
A

 

 

µ A

xa b  
Трикутна 














≤≤
−
−

≤≤
−
−

≤∨<

=

dxmпри
dm

dx

mxaпри
am

ax
xdaxпри0

(x)µ
A

 

µA

xa        m      b
 

Трапецієподібна  














≤≤
−
−

≤≤

≤≤
−
−

≤∨<

=

dxcпри
dc

dx
cxbпри1

bxaпри
ab

ax
xdaxпри0

(x)µ
A

 

µA

xa       b         c      d
 

Прямокутна  





≤≤
<∨<

=
bxaпри1

xbaxпри0
(x)µ

A
 

µA

xa                b
 

Функція Гауса  
 

0a
2m)(xa

e(x)Аµ >−⋅−=  

µ A

x m

 

Синглетон-
функція 

 
 





≠
=

=
mxпри1

mxпри0
(x)µ

A
 

µA

xm  
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В першій групі операцій із фази-множинами виділяють  три основних операції:  

� І. Реалізу є перетин фази-множин. Перетин фази-множин A1∩A2 визначається  

таким чином:  

(1.3)(x)
2

A
µ(x),

1
A

µmin(x)
2

A
1

A
µ:Xx













=∩∈∀  

� АБО. Реалізу є поєднання  фази-множин. Поєднання  двох фази-множин A1∪A2  

визначається  таким чином:  

(1.4)(x)
2

A
µ(x),

1
A

µmax(x)
2

A
1

A
µ:Xx













=∪∈∀  

� НІ. Реалізу є логічне заперечення  фази-множини. Логічне заперечення  ¬A фази-

множини A визначається  таким чином:  

(1.5)(x)
A

µ1(x)
A

µ:Xx −=¬∈∀  

На рис. 1.1 подається  графічне зображення  поданих вище визначень . Логічні операції  

над фази-множинами можуть  бути розглянуті як узагальнення  класичних операцій над  

множинами.  

А2

µА

1

А1

х

А2

µА

1

А1

х

21
AA ∩

2A∪

µА

1

х

А

¬А

 

Рисунок 1.1 – Операції із фази-множинами  

 

В процесі  подальшого розвитку  фази-логіки були визначені також інші  оператори для  

фази-множин.  Ці оператори розр ізняються  загальновживаністю,  сумісністю та  насамперед  

ступенем вірогідності, що змінюється  в межах від інту їтивно  ар гументованих до  

аксіоматично обґрунтованих визначень . Розр ізняють  два основних класи таких оператор ів: 

� Т -норми, що використовуються  для  моделювання  перетину  фази-множин;  

� Т -Со-норми (також інколи позначаються  як S-норми),  що використовуються  для 

моделювання  поєднання  фази-множин.  
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Функція  Т : [0,1]�[0,1]→[0,1] називається  Т -нормою, якщо вона відповідає таким  

умовам:  

( ) ( )

( ) ( )

( ) ( )

( )( ) ( )( )     ості)асоціативнумова(       (x)3µ,(x)A2µ(x),A1µTT (x)3µ(x),A2µT(x),A1µT 4.

                ості)комутативн умова(       (x)A1µ(x),A2µT(x)A2µ(x),A1µT3.

ті)монотонносумова(     (x)A4µ(x)A2µта(x)A3µ(x)A1µ якщо

(x)A4µ(x),A3µT(x)A2µ(x),A1µT

XxxAµ (x)Aµ1,T 1(x),AµT 0;(0,0)T1.

2.

=

=

≤≤

≤

∈∀ )(===

 

Функція S: [0,1]�[0,1]→[0,1] називається Т-Со-нормою або S-нормою, якщо вона  

відповідає таким умовам: 

( ) ( )

( ) ( )

( ) ( )

( )( ) ( )( ) ості)асоціативн умова(  (x)3µ,(x)A2µ(x),A1µTS (x)3µ(x),A2µT(x),A1µS 4.

                    ості)комутативн умова((x)A1µ(x),A2µS(x)A2µ(x),A1µS3.

                  ті)монотоннос умова(    (x)A4µ(x)A2µта(x)A3µ(x)A1µ якщо

(x)A4µ(x),A3µS(x)A2µ(x),A1µ

XxxAµ (x)Aµ0,S 0(x),AµS 1;(1,1)S1.

 

S2.

=

=

≤≤

≤

∈∀ )(===

 

Оператори обох цих класів можуть  бути параметризованими та непараметризованими. 

Табл. 1.2 надає огляд найбільш відомих непараметризованих Т -норм та Т -Со-норм. 

 

Таблиця  1.2 – Непараметризовані оператори 

 

Непараметризовані 

оператори 

T -норма: 

T (µA1(x), µA2(x)) = 

T-Co-норма або S-норма:  

S(µA1(x), µA2(x)) =  

максимум/мінімум  

T min/Smax 

min{µA1(x), µA2(x)}  max{µA1(x), µA2(x)}  

Обмежена р ізниця /  

Обмежена сума  

T обмеж/Sобмеж 

 

max{0, µA1(x)+µA2(x)-1} 

 

min{1, µA1(x)+µA2(x)}  
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Продовження  табл. 1.2  

Алгебраїчний 

добуток/ 

Алгебраїчна сума  

T алгебр/Sалгебр 

 

 

µA1(x)⋅µA2(x)  

 

 

µA1(x)+µA2(x)-µA1(x) ⋅µA2(x)  

Drastisches-добуток/ 

Drastisches-сума 

T drastisch/Sdrastisch 

min{µA1(x), µA2(x)}  

якщо max{µA1(x), µA2(x)} = 1  

0 інакше  

max{µA1(x), µA2(x)}  

якщо min{µA1(x), µA2(x)} = 0  

1 інакше  

Hamacher-добуток/ 

Hamacher-сума  

T Hamacher/SHamacher 

(x)
A2

µ(x)
A1
µ(x)

A2
µ(x)

A1
µ

(x)
A2
µ(x)

A1
µ

⋅−+
⋅

 
(x)A2µ(x)A1µ1

(x)A2µ(x)A1µ2-(x)A2µ(x)A1µ

⋅−
⋅⋅+

 

Добуток Ейнштейна/  

Сума Ейнштейна  

T Eйншт/SEйншт  

(x)]A2µ(x)A1µ(x)A2µ(x)A1[µ-2

(x)A2µ(x)A1µ

⋅−+
⋅

 
(x)A2µ(x)A1µ1

(x)A2µ(x)A1µ

⋅+
+

 

 

Властивості параметризованих оператор ів на відміну  від непараметризованих можуть  

змінюватися  в широких межах зал ежно  від області їх застосування  за допомогою  

відповідного параметра. Деякі приклади таких оператор ів наведені в табл. 1.3.  

 

Таблиця  1.3 – Параметризовані оператори 

 

Параметризовані 

оператори 

T-норма: 

T(µA1(x), µA2(x), γ) = 

T-Co-норма або S-норма: 

S(µA1(x), µA2(x), γ) = 

Hamacher-перетин/ 

поєднання 

T Ham_перетин/SHam_поєднання 





 ⋅−+⋅+

⋅

(x)
A2

µ(x)
A1

µ(x)
A2

µ(x)
A1

µγ )-(1γ

(x)A2µ(x)A1µ  

γ≥0 

(x)
A2

µ(x)
A1

µγ )(11

(x)
A2

µ(x)
A1

µγ )-(2-(x)
A2

µ(x)
A1

µ

⋅⋅−−
⋅⋅+  

γ≥0 

Yager-перетин/ 

поєднання 

T Yager_перетин/SYager_поєднання 





















 −+−−
1/γγ

(x))A2µ(1
γ

(x))A1µ(11,min1

γ≥0 





















 +
1/γγ

(x)
A2

µ
γ

(x)
A1

µ1,min

γ≥0 

 

Ще більш у загальненим, ніж фази-І- та фази-АБО-оператори є γ-оператор  (також в 

літер атур і зу стр ічається  позначення  Z комп), який дозволяє здійснити певну  компенсацію  

однієї величини іншою. Цей оператор  становить  комбінацію алг ебраїчного добутку й 
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алгебраїчної суми. Можна сказати, що γ-оператор  може бути безперервно визначений між  

перетином та поєднанням фази-множин:  

(1.6)
γ

(x))
A2

µ(x)
A1

µ(x)
A2

µ(x)
A1

(µγ1
(x))

A2
µ(x)

A1
(µγ )(x),

A2
µ(x),

A1
(µкомпZ:Xx ⋅−+⋅−⋅=∈∀

 

Змінюючи γ в інтервалі [0,1] можна реалізувати моделювання  від логічного І до  

логічного АБО за допомогою лише одного оператора: 

 

γ = 0:   Z комп →  Tалгебр 

γ = 1:   Z комп →  Sалгебр 

 

До другої групи оператор ів, що визначають  відношення  між фази-множинами, які  

містять  до себе р ізні базові елементи, належать  фази-співвідношення . Щоб пояснити це  

поняття , необхідно звернутись  до визначення  векторного добутку . 

Векторний добуток A1×...×Am фаззи-множин A1...,Am із базовими множинами  

X1...,Xm визначається  в простор і добутку  X1×...×Xm таким чином:  

(1.7))
m

(x
m

A
µ),.. . ,

1
(x

1
A

µmin)
i

(x
i

A
µmin

m

1i

)
m

x,... ,
1

(x
2

A...
1

A
µ:

i
X

i
x













=












=
=××∈∀  

На основі поняття  векторного добутку  можна визначити фази-співвідношення . Фази-

співвідношення  можуть  розглядатися  як у загальнення  співвідношень  класичних множин.  

Фази-співвідношення  являє собою фази-множину , яка є підмножиною простору  добутку 

X1×...×Xm базових множин  X1...,Xm. Фази-співвідношення  (нечітк е співвідношення) R у  

простор і добутку  X1×...×Xm із базовими множинами X1...,Xm в изначається  таким чином:  

( ) ( )( ) ( ){ } (1.8)                    XXx,x|x,xµ,x,x)X,R(XR
m1m1m1Rm1m1

××⊆== LKKK  

Зворотне фази-співвідношення  R
-1

 бінарного фаззи-співвідношення  (1.8)  визначається  

як 

( ){ } (1.9)
2

X...
1

X)
2

x,
1

(x|)
1

x,... ,
2

(x
R

µ),
2

x,
1

(x-1R ××⊆=  

Нечіткі бінарні співвідношення  R1(X1, X2) та R2(X2, X3) з р ізними просторами добутку  

та спільним базовим елементом X2 поєднуються  за допомогою оператора композиції  

(оператора з 'єднання) "°". З'єднання  (зчеплення) R12(X1, X3) двох бінарних фази-

співвідношень  R1(X1, X2) та R2(X2, X3) із базовими множинами X1, X2, X3  

R12(X1, X3) = R1(X1, X2)°R2(X2, X3)  або R12 = R1°R2   (1.10) 

може бути визначене за допомогою деяких оператор ів, найб ільш відомі з них наведені  

у  табл. 1.4. 
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Таблиця  1.4 – Оператори з 'єднання  
 

R12 = R1°R2 )
3

x,
1

(x
12

R
µ  

max-min  

(максимум мінімуму ) 























∈
)

3
x,

2
(x

2
R

µ),
2

x,
1

(x
1

R
µmin

2
X

2
x

max  

max-p rod 

(максимум добутку ) 











⋅
∈

)
3

x,
2

(x
2

R
µ)

2
x,

1
(x

1
R

µ

2
X

2
x

max  

max-average 

(максимум середнього 

значення) 













+
∈

⋅ )
3

x,
2

(x
2

R
µ)

2
x,

1
(x

1
R

µ

2
X

2
x

max
2

1
 

 

1.2 Фази-контролер 

 

У  попередньому  розділі були представлені основні  поняття  та механізми фази-теор ії  

без огляду  на практичні аспекти її  використання  в техніці регулювання . В цьому  розділі 

розглядаються  засоби побудови на  основі  неч іткої лог іки фази-контролер ів та їх практичне  

застосування  в межах техніки автоматизації.  

Основну  структуру  фаззи-контролера можна представити у  вигляді трьох блоків   

(рис. 1.2): 

� вхідний фільтр ;  

� фази-блок;  

� вихідний фільтр . 

лінгвістичні
терми

правила

експертні знання

вхідний
фільтр фази-блок

вихідний
фільтр

Фази-контролер
UCEq

e

Xk

m

 

Рисунок 1.2 – Структура фази-контролера 

Вхідні та вихідні фільтри фази-контролера служать  для  у згодження  параметр ів об'єкта  

регулювання  із параметрами фази-блока. Вхідні та вихідні фільтри можуть  включати в себе  
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динамічні компоненти фази-контролера (наприклад, інтегр атори та ланки диференціювання)  

або складатися  із чисто статичних компонентів (наприклад, суматори та підсилювачі). Фази-

блок утворює центральну  частину  фази-контролера. Передавальна функція  фази-блока є  

чисто статичною, фази-блок не містить  у  собі жодних динамічних компонентів та внутр ішніх 

змінних стану . 

Завданням  вхідного фільтра є перетворення  вимірюваних величин системи E1...Ee на  

вхідні величини X1...Xm фази-блока. У  випадку , якщо для  утворення  значення  однієї в хідної  

величини потр ібні значення  декількох змінних системи , кількість  е величин системи E1...Ee  

може відр ізнятись  від кількості m в хідних величин X1...Xm фази-блока. Найпростішим  

прикладом цього є використання  помилки регулювання  як вхідної величини фази-блока.  

Помилка регулювання  Xd обчислюється  виходячи із заданого значення  величини r, що  

регулюється , та поточного значення  цієї ж величини y (Xd  =  r  −  y). 

Завданням вихідного фільтра є у згодження  значення  вихідної величини фази-блока із  

керуючою величиною перетворювача або безпосередньо об'єкта регулювання . Принципово  

вихідний фільтр  може містити будь-які статичні та динамічні функції, проте як правило він 

містить  тільки підсилювач або інтегр атор . Інтегр атор  у  вихідному  фільтр і здійснює  

перетворення  форми керуючого сигналу . 

Ядро фази-контролера утворює фази-блок. Вище було зазначено, що фази-блок не  

містить  жодних динамічних компонентів. Це означає, що будь-який фази-блок можна  

представити за допомогою статично ї функції F: X→C, що пов 'язу є базові множини X1,...,Xm 

вхідних величин із базовою множиною вихідної величини С. Цей зв 'язок здійснюється  за  

допомогою якісних знань  експерта. Це означає, що функція  c = F(x), де  x∈X, c∈C, не 

записується  математично в аналітичній формі, а встановлюється  за допомогою л інгвістичних 

термів (фази-множин) та правил на основі інших ступенів свободи. Функція  F(x) є як 

правило нелінійною. Це виклик ає питання : що  власне нового привносить  фази-регулювання? 

Адже нелінійна передавальна функція  із багатьма в хідними змінними  може бути реалізована  

за допомогою багатовимірного регулятора. Новим є метод розробки системи регулювання , 

вербальне формулювання  експертних знань  за допомогою лінгвістичних правил. 

Структура фази-блока показана на рис. 1.3. Фази-блок складається  з трьох частин:  

 

 

� блок фазифікації;  

� блок інференції;  

� блок дефазифікації.  
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лінгвістичні
терми правила

експертні знання

фазифікація інференція дефазифікація

фази-блок

 

Рисунок 1.3 – Структура фази-блока 

 

У  техніці регулювання можуть  бути виміряні тільки однозначні  величини,  і тільки  

однозначні керуючі величини можуть  бути задані об'єкту  регулювання; тому  використання  

фази-множин безпосередньо як технічного сигналу  неможливе. Фазифікація та  

дефазифікация здійснюють  перетворення відповідно однозначних вхідних величин на в хідні  

фази-множини та вихідних фази-множин на однозначні вихідні величини.  

У  процесі фазифікації кожному  елементарному  висловленню  ЯКЩО-частини  

правила ставиться до відповідності ступінь  приналежності. Ступінь  приналежності  

розраховується із функції приналежності л інгвістичного терма та актуального вхідного  

значення елементарного висловлення. Графічне зображення фазифікації надається на   

рис. 1.4. 

помилка регулювання

Позитивна велика

µ

1

Позитивна

0.25

0.67

0.4

Поточне значення помилки регулювання є

позитивним із ступенем приналежності

0.67 та позитивним великим із ступенем

приналежності 0.25. Це означає, що

значення помилки регулювання є

позитивним, але ще не дуже великим.

 

Рисунок 1.4 – Фаззифікація  

Завданням  інф еренції  є перетворення якісного експертного знання на закон  

регулювання, що може бути реалізований технічно. Вхідними даними для процесу  

інференції є  фази-правила та ступінь  приналежності,  з яким є справедливим  елементарне  
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висловлення Ek, i(xk). На основі результатів фазифікації та фази-правил в процесі інференції  

відбувається формування вихідної фази-множини  B
*
. Інф еренцію  можна  умовно поділити на  

три етапи : 

� агрегація; 

� імпл ікація; 

� акумуляція. 

У  процесі агрегації визбируються р ізні елементарні висловлення, що належать  до  

одного правила, та утворюється ступінь  приналежності, з яким є справедливим елементарне  

висловлення ЯКЩО-частини фази-правила. Кожна ЯКЩО-частина правила складається з 

декількох елементарних висловлень , які зводяться за допомогою логічних зв 'язків до єдиного  

комплексного висловлення. Як результат для кожного активного правила визначається 

ступінь  приналежності, з яким висловлення у ЯКЩО-частині є справедливим. Операторами  

агрегації можуть  бути будь-які з наведених вище оператор ів, але в техніці регулювання 

використовується як правило лише І-оператор . І-оператор  може бути реалізований двома  

способами, тому  можна виділити два типи реалізації оператора агрегації: 

� мінімум-агрегація: 

(1.11){1,...n}iпри)
k

(x
ik,

E
m

1k
)

m
(x

im,
E),...,

1
(x

i1,
Emin)x(

i
E min ∈

=
==







  

� добуток-агрегація: 

(1.12)                                               
m

1k
)

k
(x

ik1,
E)m(x

im1,
E...)

1
(x

i1,
E)x(

i
E ∏

=
=⋅⋅=  

Графічне зображення мінімум-агрегації надається на рис. 1.5. Розглядається правило, 

ЯКЩО-частина якого має вигляд: 

ЯКЩО Помилка регулювання позитивна ТА Похідна від  помилки регулювання  

позитивна велика,... 

Помилка регулювання є позитивною зі ступенем приналежності 0.7 та Похідна від  

помилки регулювання є позитивною великою зі ступенем приналежності 0.6. Відповідно  до  

формули (1.11), агрегація дає результат – ступінь приналежності, з яким виконується ЯКЩО-

частина правила, – 0.6. 
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Рисунок 1.5 – Мінімум-агрегація  

 

В процесі імплікації для кожного активного правила залежно від ступеня  

приналежності Ei(x), з яким воно виконується, визначається фази-множина B
*

i. Для  

здійснення імплікації використовуються оператори композиції. Фази-множина B
*

i є  

складовою частиною базової множини Ci вихідної величини C фази-блока. Існує декілька  

методів імплікації, найбільш відомі з них наведені в табл.  1.5. Найчастіше як оператор  

імпл ікації в техніці регулювання використовується І-оператор . Графічне уявлення імпл ікації,  

що здійснюється за допомогою І-оператора, представлене на рис. 1.6.  

 

Таблиця 1.5 – Методи імпл ікації 
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Рисунок 1.6 – Імплікація 

 

Останнім етапом інференції є акумуляція. Завданням акумуляції є об'єднання  

результатів інференції окремих фази-правил. Результатом акумуляції є фази-множина B*
,  що  

утворюється шляхом об'єднання окремих фази-множин B
*

i: 

U
n

1i
(1.13)                                                                              *

iB*B
=

=  

Акумульована фази-множина B
*
 являє собою остаточний результат процесу  

інференції. Функція приналежності результуючої фази-множини утворюється за допомогою 

оператора акумуляції Akk: 

(1.14)                                                      (c)
*
i

B
µAkk

n

1i
(c)

*B
µ:Сс

=
=∈∀  

Оператор  акумуляції Akk здійснює об'єднання фази-множин, тому  для його реалізації 

можна застосовувати будь-який з розглянутих вище оператор ів для фази-множин.  

Оператори, що є найбільш поширеними, наведені в табл. 1.6. 

 

Таблиця 1.6 – Оператори акумуляції 

 

Оператори акумуляції Akk T-Co-норма bzw. S-норма 

Максимум (за Mамдані) Sm ax 

Обмежена сума  Sобмеж 
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Найчастіше як оператор  акумуляції виступає максимум-оператор . У  цьому  випадку  

акумульована фази-множина визначається таким чином: 

(1.15)                          (c)
*
i

B
µmax

n

1i
(c)

*
n

B
µ(c),...,

*
1

B
µmax(c)

*B
µСс

=
==∈∀

















 

Функція приналежності результуючої фази-множини, що визначається за допомогою  

максимум-оператора, наведена на рис. 1.7. 
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Рисунок 1.7 – Акумуляція 

 

У  техніці регулювання як керуючі сигнали можуть бути використані лише  однозначні 

величини, тому  акумульована у  процесі інференції фази-множина  не може  бути використана  

як керуюча величина об'єкту  регулювання; необхідна дефазиф ікація отриманого результату . 

У  процесі дефазифікації відбувається перетворення акумульованої фази-множини на  

однозначну  вихідну  величину . Існує велика кількість методів дефазифікації, метою яких є  

визначення такої однозначної вихідної величини, яка б як можна точніше представила  

акумульовану  фази-множину . Серед найбільш поширених сл ід зазначити такі методи  

дефазифікації: 
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� метод мінімуму, коли як вихідне значення виступає максимальне значення  

множини Сmin
, яку  утворюють елементи, що належать до терму  із мінімальними  

значеннями функції приналежності акумульованої фази-множини (рис. 1.8). 

� метод максимуму, коли як вихідне значення виступає максимальне значення  

множини Сmax
,  яку  утворюють елементи,  що належать до  терму  із максимальними  

значеннями функції приналежності акумульованої фази-множини (рис. 1.8). 

� гравітаційний метод, коли розраховується центр  ваги площі функції 

приналежності вихідно ї величини, яка складається зі всіх лінгвістичних змінни х 

(рис. 1.8). Вихідна величина визначається таким чином: 

(1.16)
µ(c)dc

µ(c)dcc
S

X
∫

∫ ⋅
=  

� сінглетон - метод – спрощений вар іант гравітаційного метода. Застосування цього  

метода дозволяє зменшити витрати часу  на розрахунки, тобто збільшити  

швидкість обчислювальних процесів та зменшити витрати пам'яті. Відхилення  

результатів, отриманих за допомогою  цього метода, від  результатів розрахунків за  

гравітаційним методом незначні.  
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Рисунок 1.8 - Методи дефазифікації 

 

Розглянемо докладніше найпростіший і тому  найбільш поширений метод  

дефазифікації – сінглетон-метод. Цей метод базується на гравітаційному  методі і тому  

передбачає  розрахунок проекції центра ваги фігури, яка утворюється шляхом накладення  
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усіх усічених площ, що відповідають результату кожного активного правила. Звичайно, це  

стосується випадку  наявності декількох активних термів вихідної змінної.  

Як було зазначено вище, центр  ваги ХS результуючої площі визначається шляхом 

інтегрування результативної функції µ(с) (рис. 1.9). 

с

µ

1

µ1

µ2

µА(с)

µВ(с)

ХS

µАO(с) µВO(с)

 

Рисунок 1.9 - Визначення центра ваги результуючої площі 

Якщо усічені функції приналежності розглядати окремо, а значення усічених функцій  

визначати шляхом множення  

 

(1.18),(c)
BO

µ
2

µ(c)
B

µ

(1.17)(c)
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µ
1
µ(c)

A
µ

⋅=

⋅=
 

то методика значно спрощується: 

 

(1.19)
dc (c)µ  µ  dc (c)µ  µ

dc (c)µ  c µ  dc (c)µ  c µ
  X

BO2AO1

BO2AO1

S

∫ ∫
∫ ∫

⋅+⋅

⋅⋅+⋅⋅
=  

 

Якщо розглянути останнє рівняння, то можна помітити, що тепер  під інтегралом 

стоять тільки функції µАО(с) та µВО(х), а ці функції не залежать від  процесу , тобто  площа під  

ними може бути розрахована ще під час проектування. 
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Інтеграл в чисельнику  дробі відповідає  обертальному  моменту  М, а інтеграл в  

знаменнику  відповідає усіченій площі А. Відповідно до цього рівняння спрощується ще: 

(1.20)
...  A  µ  A  µ

...  M  µ  M  µ
  X

ВO2АO1

ВO2АO1
S +⋅+⋅

+⋅+⋅
=  

З цього рівняння видно,  що форма функцій приналежності вихідної фази-змінної не 

впливає на кінцевий результат. Зараз важливими є тільки площі та їхнє  розташування на осі.  

Якщо вибрати функції приналежності µАО(с) і µВО(с) незалежними від с, наприклад,  

прямокутники з висотою, яка дорівнює одиниці, то ці функції можна винести за знак  

інтеграла і скоротити. У цьому  випадку  ми отримаємо формулу  розрахунку  центра ваги за 

сінглетон - методом: 

(1.21)
....  µ  µ

...  с  µ  с  µ
  X

21

В2А1
S ++

+⋅+⋅
=  

На рис. 1.10 показані сінглетон-функції усічених функцій приналежності µАО(с) і 

µВО(с). 

с

µ

1
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µ2

µА( с)
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Рисунок 1.10 - Сінглетон-функції усічених функцій приналежності 

Усі ступені свободи фази-блока можна розподілити на два класи: 

1. Параметричні: 

� лінгвістичні терми (форма та параметри функцій приналежності); 

� фази-правила; 

� вагові коефіцієнти.  

2. Алгоритмічні: 

� оператори агрегації; 

� оператори імплікації; 
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� оператори акумуляції; 

� метод дефазифікації.  

Визначальну  роль при настроюванні фази-блока грають параметричні ступені свободи,  

тому  що саме база правил та лінгвістичні терми представляють експертне знання. При 

розробці фази-блока оператори інференції та метод дефазифікації завжди розглядаються 

підпорядковано, головна увага приділяється визначенню параметричних ступенів свободи.  

Значно  легше помітити зміни в роботі системи, що  викликані зміною  лінгвістичних термів  

або правил, ніж зміни,  що спричиняються варіацією методу  дефазифікації або  операторів 

інференції. Алгоритмічні ступені свободи здебільшого встановлюються виходячи із вимог до  

швидкодії (це стосується насамперед до вибору  методу  дефазифікації) та сталості системи. В  

техніці регулювання існують установки, яким традиційно надається перевага при 

проектуванні фази-блок ів. Як оператори інференції, наприклад, найчастіше вживаються Max-

Min- та Max-Prod-інференція. Огляд найбільш поширених операторів інференції 

представлений в табл. 1.7.  

 

Таблиця 1.7 – Оператори інференції 

 

Метод інференції Агрегація (І) Імплікація  Акумуляція 

Max-Min Мінімум або добуток Мінімум Максимум 

Max-Prod Мінімум або добуток Добуток Максимум 

Sum-Prod Мінімум або добуток Добуток Сума 

Sum-Min Мінімум або добуток Мінімум Сума 

 

Математичний опис операторів інференції у  вигляді формул надається в табл. 1.8. 

 

Таблиця 1.8 – Формульне представлення деяких операторів інференції 
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Продовження табл. 1.8  
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Загальна структура фаззи-контролера зображена на рис. 1.11. Ця схема може служити 

допоміжним матеріалом при проектуванні фази-контролерів. 
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Рисунок 1.11 – Загальна структура фази-контролера 
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1.3 Основні етапи проектування фази-контролерів 

 

Процес проектування фази-контролера складається з чотирьох етапів.  

1. Аналіз системи. На початку  проектування обов'язково треба провести аналіз  

системи. Процедура аналізу включає в себе як вибір  структури контуру 

регулювання, так і вибір  вимірюваних величин та вхідних величин фази-

контролера, що визначаються виходячи із результатів вимірювання; визначення 

вихідних величин фази-контролера, тобто керуючих величин об 'єкта 

регулювання. На цьому  етапі можуть також бути встановленими вхідні й вихідні 

фільтри, що вимагає вірного добору коефіцієнтів підсилювання або масштабних 

коефіцієнтів у  вхідних та вихідних фільтрах.  Ця процедура є обов'язковою при 

застосуванні нормованого фази-блока, тому  що в такому  випадку  необхідно  

узгодити величини системи із вхідними та вихідними величинами фази-блоку , 

що змінюються в одиничному  інтервалі (наприклад, [-1,1] або [1,100]). 

Використання нормованих фази-блоків дозволяє інколи стандартизувати їх,  

використовувати той самий фази-блок в різних системах керування із різними 

параметрами, змінюючи лише масштабні коефіцієнти вхідних та вихідних 

фільтрів. Масштабні коефіцієнти вхідних та вихідних фільтрів грають таку  ж 

важливу  роль, як і коефіцієнти підсилення в класичних регуляторах. Перший 

етап проектування є дуже відповідальним і потребує глибоких знань в області 

класичних методів регулювання та цифрової обробки сигналу . Помилки, що  

виникають на цьому  етапі, набагато складніше виправити, ніж ті, що виникають 

на наступних етапах.  

2. Встановлення алгоритмічних ступенів свободи. На цьому  етапі здійснюється 

визначення основних властивостей фази-блока. Наприклад, метод дефазифікації 

визначає швидкодію фази-блока та його сталість. 

3. Встановлення параметричних ступенів свободи. Цей етап є центральним в  

усьому  процесі проектування, його можна розподілити на три кроки: 

� встановлення можливих інтервалів зміни вхідних та вихідних величин. При 

цьому  припускається, що на попередньому  етапі були визначені властивості 

об'єкта регулювання та масштабні коефіцієнти фільтрів; 

� встановлення лінгвістичних термів та їх функцій приналежності для всіх 

лінгвістичних змінних. Як правило у  техніці регулювання обираються 

трикутні, трапецієподібні та сінглетон-формені функції приналежності. Слід  
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зауважити, що наявність невизначених областей є небажаною, всі функції 

приналежності вхідних фази-множин обов'язково мають перекриватись; 

� складання бази правил. На жаль, для цього не існує жодного 

систематизованого  алгоритму , тому  центральний етап проектування фази-

регулятора не має такої загальноприйнятої систематики, як при 

проектуванні класичних регуляторів. Це значно ускладнює процес 

проектування - дуже часто трапляються випадки,  коли різні настройки фази-

блока зумовлюють майже ідентичні його передавальні властивості.  

4. Моделювання спроектованого контуру регулювання. На цьому  етапі 

відбувається перевірка розробленого фази-контролера. У випадку , якщо 

результати моделювання є незадовільними,  потрібно змінити певні параметри 

фази-контролера. 

На рис. 1.12 процес розробки фази-контролера представляється у  наочній формі.  
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Рисунок 1.12 – Процес розробки фази-контролера 

 

1.4 Типи фази-контролерів 

 

Фази-контролери, як і класичні регулятори, можуть бути реалізовані у  вигляді П-

регулятор ів, ПІ-регулятор ів, ПД-регулятор ів та ПІД-регулятор ів [4]. Проте слід пам'ятати,  
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що ця  аналогія  не є повною, і фази-П-регулятор , наприклад, не є аналогом класичного П-

регулятора. Нижче розглянуті основні типи фази-контролер ів. 

1. Фази-П-регулятор 

Фази-П-регулятором називається  фази-контролер  з однією в хідною величиною,  

причому  при зростанні вхідно ї величини е вихідна величина u також зростає або  

принаймні залишається  незмінною, тобто: 

u = F(e) 

Це визначення  збігається  з вимогами до  монотонної (проте не  строго монотонної)  

передавальної функції  та  являє собою значне  пом'якшення  поняття  

пропорційності. Як фази-П-регулятор  може розглядатися , наприклад, зона  

нечутливості.  

2. Фази-ПІ-регулятор 

Фази-ПІ-регулятором називається  фази-контролер , вхідними величинами якого є  

помилк а регулювання  e та швидкість  її  змінювання  (тобто перша похідна) ė, а  

вихідною величиною є похідна від керуючого сигналу  ů, причому  як при 

зростанні помилки регулювання  e, так і при зростанні ї ї похідної ė вихідна  

величина ů зростає або принаймні залишається  незмінною: 

ů = F(e, ė) 

3. Фази-ПД-регулятор 

Фази-ПД-регулятором називається  фази-контролер , вхідними величинами якого є 

помилк а регулювання  e та швидкість  її зміни (тобто перша похідна) ė, а вихідною  

величиною  є керуючий сигнал u, причому  як при зростанні  помилки  регулювання 

e, так і при зростанні  ї ї похідно ї ė вихідна  величина  u зростає або  принаймні  

залишається  незмінною: 

u = F(e, ė) 

4. Фази-ПІД-регулятор 

Фази-ПІД-регулятор  може бути реалізований за допомогою двох алгоритмів – 

алгоритму  встановлення  керуючої величини  та алгоритму  встановлення  

швидкості зміни керуючої величини: 

� при реалізації  за першим алгоритмом  фаззи-ПІД-регулятором називається  фази-

контролер , вхідними величинами якого є помилка регулювання  e, її перша похідна  

ė та інтегр ал від помилки регулювання  ∫edτ, а вихідною величиною є керуючий 

сигнал u: 

u = F(e, ∫edτ, ė) 
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� при реалізації за другим алгоритмом фази-ПІД-регулятором називається  фази-

контролер , вхідними величинами якого є помилка регулювання  e, її перша ė та  

друга ë похідні, а вихідною величиною є похідна керуючого сигналу  ů. 

ů = F(e, ė, ë) 

 

1.5 Варіанти побудови контурів регулювання із фази-регулятором 

 

Існує велика к ількість  р ізноманітних вар іантів побудови контур ів регулювання  із  

фази-регулятором. Цей розділ присвячений розгляду  найбільш поширених з них.  

Найпростіша  структура показана  на рис. 1.13.  Ця  структура представляє собою  

одноконтурну  систему  регулювання , аналогічну  класичній одноконтурній системі.  Замість  

класичного регулятора контур  містить  фази-регулятор , що має одну  вхідну  та одну  вихідну  

величини.  
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Рисунок 1.13 – Одноконтурна система регулювання  з фази-регулятором 

 

Трохи ускладнений вар іант ціє ї структури є система, показана на рис. 1.14. Фази-

контролер в цьому  випадку  має більш, ніж одну  вхідну  величину , тому в системі з'являється 

додатковий блок підготовки вимірюваних величин.  Його завданням є розрахунок вхідних 

величин регулятора, виходячи із значення  помилки регулювання  та надання  отриманих 

величин регулятору . Принципово при реалізації цього блока можливе використання  будь-

яких динамічних та статичних оператор ів. 
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Рисунок 1.14 - Одноконтурна система регулювання  з фази-регулятором 
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Слід зауважити, що структури, подібні до наведених, на практиці вживаються  дуже 

обмежено. Причиною є те, що проектувальники ще "не довіряють" фази-контролеру , теор ія 

фази-регулювання  в даний час ще не має однозначних простих методів оцінки фази-систем  

регулювання . Тому  досить  часто структур  із одним лише фази-регулятором намагаються  

уникнути. В більшості випадків проектувальники систем фази-регулювання  прагнуть 

поєднати достоїнства фази-регулятор ів та класичних регулятор ів. Дуже часто 

використовуються  структури, в яких до випробуваного класичного контуру  регулювання  

(наприклад, до контуру  з ПІД-регулятором) підключається  фази-регулятор , що має 

компенсувати недол іки класичного регулятора або втрутитися  у  разі особливих режимів  

роботи. Це дає можливість  переключатись  залежно від поточного режиму  роботи системи  

між двома концепція ми регулювання: при незначних відхилення х від робочої точки є  

доцільним використання  класичного регулятора (наприклад, ПІД-регулятора), при значних 

швидких змінах збудження  або завдання  хороші результати дає фази-регулятор . Одним із  

вар іантів реалізації такого підходу  є структура, наведена на рис. 1.15. Контур  регулювання  

містить  фази-контролер , що підключається  паралельно до класичного регулятора. Вхідною  

величиною  фази-контролера може бути, наприклад, помилка регулювання  та похідна від  неї,  

на виході фази-контролер  утворює коригувальний сигнал, що складається  із сигналом на  

виході класичного регулятора. 
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Рисунок 1.15 – Контур  регулювання з паралельною фази-корекцією 

 

Широкі можливості для фази-регулювання відкриваються в області адаптив ного  

регулювання. Йдеться про on-line-покращення властивостей контуру  регулювання, що є,  

наприклад, доцільним у  системах, в яких вид перехідного процесу  залежить  від  моменту  

його початку . В таких системах шляхом модифік ації структури регулювання розробляється 

фази-контролер , здатний до  самоорганізації,  який через зміну  своїх параметр ів залежно  від  

стану  системи функціонує можливо оптимально. Найпростіша структура регулювання такого 

типу  надається на рис. 1.16. 
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Рисунок 1.16 – Структура контуру  регулювання з адаптивним фази-контролером 

(пряма адаптація)  

 

Основою для адаптації фази-контролера служать  в цьому  випадку  спостер ігання за  

величиною помилки регулювання, виходячи з якої визначається через певний критер ій якості  

індекс якості, що характеризує якість  регулювання. "Розум" адаптивного регулятора 

міститься у  блоці Алгоритм адаптації у  вигляді р ізноманітних команд, що виконуються 

залежно від значення індексу  якості. Таким чином, алгоритм адаптації проектується як фази-

алгоритм у  формі ЯКЩО...ТО-правил. Ця структура являє собою так звану  пряму  адаптацію.  

Більш складною є  структура непрямої адаптації.  Найпростіша форма такого контуру 

регулювання наведена на рис. 1.17. В цьому  випадку  структура алгоритму  адаптації  

ускладнюється. Блок Алгоритм адаптації складається з двох блоків: Ідентифікація системи  

та Проектувальник фази-контролера. Протягом процесу адаптації виконується аналіз  

поточних значень  регульованої координати  та заданого значення цієї ж координати. На  

основі даних аналізу  відбувається зміна параметр ів фази-контролера. Здійснення зміни  

параметр ів є завданням блока Проектувальник фази-контролера. 
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Рисунок 1.17 – Структура контуру  регулювання з адаптивним фази-контролером 

(непряма адаптація)  
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Така стратегія адаптації може бути реалізована в концепції регулювання, що 

ґрунтується на моделі процесу . Структура контуру  регулювання такого типу  представлена на  

рис. 1.18. В цьому  випадку  зміна параметр ів фази-контролера відбувається на основі 

пор івняння процесів, що протікають  в реальній системі,  з процесами в ідеал ізованій  моделі  

(так званої моделі  процесу ). Відхилення регульованої координати, що вимірюється в 

реальній системі,  від значення цієї  ж координати  в моделі процесу  (у  разі необхідності  може  

також анал ізуватися похідна від  нього) використовується як сигнал  навчання. Це  відхилення  

та його похідні (у  більшості випадків до уваги приймається лише перша похідна) можуть  

бути проаналізовані  за допомогою ще одного  фази-контролера (не адаптивного), але це  

значно ускладнює структуру  контуру  регулювання. 

 

фази-контролер

модель процесу

адаптивний фази-
контролер

об'єкт
регулювання

r
u

y

d/dt

ye

 

 

Рисунок 1.18 – Реалізація концепції регулювання, що ґрунтується на моделі процесу  

 

Більш консервативна структура адаптивного контуру  регулювання надається на  

рис. 1.19. В цьому  випадку  власне адаптивний регулятор є традиційним (наприклад, ПІД-

регулятор), і зміна його параметрів відбувається за допомогою фази-алгоритму . 

 

фази-алгоритм
адаптації

класичний
регулятор

об'єкт
регулювання

r u y

 

Рисунок 1.19 – Контур  регулювання з адаптивним класичним регулятором 
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Вибір  структури контуру  регулювання є одним з найбільш відповідальних кроків у  

розробці системи регулювання. Складна система із адаптивним фази-контролером або 

адаптивним класичним регулятором, настроювання якого відбувається за допомогою  фази-

алгоритму , демонструє кращі результати, ніж одноконтурна система (рис. 1.13). Слід  

зауважити, що взагалі практичне застосування одноконтурної системи із фази-контролером є 

дуже обмеженим через проблеми у  забезпеченні необхідного  ступеня стабільності.  Проте 

правильне настроювання складних систем потребує дуже великих витрат часу  (насамперед  

через відсутність загальновживаних методів розробки фази-систем). Задовільні результати 

можуть бути отримані при вдалій настройці в системі із паралельною фази-корекцією   

(рис. 1.15). Настроювання такої системи не потребує значних витрат часу  у  порівнянні з  

настроюванням адаптивних систем, але така система має відносно високу  надійність: при 

"випадінні" із контуру  регулювання фази-контролера система продовжує задовільно 

функціонувати. 
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2 МОДЕЛЮВАННЯ СИСТЕМ ФАЗИ-РЕГУЛЮВАННЯ ЗА ДОПОМОГОЮ 

ПРОГРАМНОГО ПАКЕТА MATLAB/SIMULINK 

 

Як зазначалося вище, важливим етапом розробки системи із фази-регулятором є 

моделювання контуру  регулювання. В даний час розроблювачі програмного забезпечення  

пропонують різні моделюючі програми, що дозволяють проводити розробку  та тестування 

фази-блоків. Деякі з  них дають можливість інтегрувати модель фази-регулятора до загальної 

моделі системи регулювання та дослідити роботу  системи в цілому , інші дозволяють лише 

перевірити роботу  фази-блока окремо від системи, до якої він інтегрується, при різних 

значеннях вхідних величин. Велика кількість проектувальників користується при 

моделюванні програмним пакетом Matlab та моделюючою програмою Simulink, що входить  

до його складу . Simulink дає можливість створювати наочні математичні моделі систем 

регулювання та досліджувати їх функціонування.  

Для моделювання фази-блоків в програмному  пакеті Matlab/Simulink було розроблено 

Fuzzy Logic Toolbox, що являє собою набір  функцій, створених у  числовому  

обчислювальному  середовищі Matlab. Fuzzy Logic Toolbox містить в собі засоби створення та 

редагування фази-блоків в межах структури Matlab. Fuzzy Logic Toolbox дає можливість  

створювати фази-блоки трьох типів [6]: 

� система інференції Мамдані (Mamdani’s fuzzy inference method) – фази-блок, вхідні 

та вихідні функції приналежності якого можуть мати будь-яку  з наведених в табл.  

1.1 форму); 

� система інференції Сугено (Sugeno’s fuzzy inference method) – фази-блок, вхідні та 

вихідні функції приналежності якого можуть бути лише константні або лінійні); 

� адаптивна нейро-фаззи система інференції (adaptive neuro-fuzzy inference system) – 

фази-блок, добір  параметрів функцій приналежності якого відбувається на основі 

заданих бажаних значень вхідних та вихідних величин фази-блока за допомогою  

методів тренування нейросіток.  

В цих методичних вказівках розглядається моделювання систем лише першого типу . 

Створені за допомогою Fuzzy Logic Toolbox фази-системи можуть бути 

промодельовані моделюючою програмою Simulink. Недоліком Fuzzy Logic Toolbox є 

відсутність можливості використання у  системі інференції Мамдані функцій приналежності 

із змінними параметрами, тобто промоделювати фази-блок, параметри функцій 

приналежності якого динамічно змінюються в процесі моделювання. Промоделювати в  

Matlab/Simulink такий адаптивний фази-блок можна, лише написавши функцію користувача, 
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що містить алгоритм обробки інформації таким регулятором, у  середовищі Matlab або С та 

помістивши цю функцію до Simulink-моделі за допомогою блока Matlab Fcn (функція 

Matlab) або S-Function (S-функція). 

Засоби, що входять до складу  Fuzzy Logic Toolbox, можна поділити на дві групи. До  

першої групи входять редактор  фази-блоків (FIS Editor), редактор  правил (Rule Editor) та 

редактор  функцій приналежності (Membership Function Editor). Ці засоби служать для 

встановлення вхідних та вихідних змінних фази-блока, їх функцій приналежності та фази-

правил. Друга група являє собою read-only Tools, тобто інструменти, які не дозволяють 

вносити зміни в фази-систему , а використовуються тільки для діагностики. До цієї групи 

належать переглядач тривимірної функції (Surface Viewer) та переглядач правил (Rule 

Viewer). 

Для того, щоб викликати Fuzzy Logic Toolbox, необхідно  набрати в командному  рядку  

Matlab fuzzy та натиснути клавішу  Enter. Після цього відкривається вікно, вигляд якого 

представлений на рис. 2.1. 

 

Це меню  використовується  для
створення , відкриття ,

збереження  та  редагуванн я
фази-блоків

Тут можна
перегляну ти ім 'я  та
тип фази-блока
(Mamdani або Sugeno)

За допомогою  цього
меню  Ви можете
встановити
оператори інференції
та метод
дефазифікаці ї

Клацніть  двічі тут лі вим
клавішем миші, щоб
відредагувати  фази-правила Це поле  служи ть  для

введення та
редагування імен
вхідних та  вихі дни х
змінни х

Клацні ть  тут двічі лівим клавішем миші,
щоб ві дредагувати  функц ії  приналежност і
ві дповідно вхідної (input) або вихідної

 

Рисунок 2.1 – Редактор  фази-блоків 

 

В цьому  вікні Ви можете створити власний фази-блок. В тому  випадку , якщо фази-

блок містить більш, ніж одну  вхідну  чи вихідну  змінну , треба вибрати в меню відповідно  
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Edit→Add input або Edit→Add output. Щоб відредагувати функції приналежності, треба 

клацнути двічі лівим клавішем миші на іконці вхідної або вихідної змінної або вибрати в  

меню  View→Edit Membershipsfunctions. Після цього на екрані з'явиться вікно редактора 

функцій приналежності (рис. 2.2), за допомогою якого можна задати функції приналежності 

певної лінгвістичної змінної або відредагувати вже існуючі. 

"Палітра змінних".
Клацніть двічі лівим
клавішем миші  на іконці
певної змінної, щоб
відредагувати її
лінгвістичні терми

Це поле показує  всі функції
приналежності активної  вхідної чи
вихідної величини

Клацніть лівим клавішем
миші на кривій, щоб
мати можливість змінити
її властивості (ім'я, тип,

числові параметри

тут Ви  можете змінити
ім'я активного
лінгвістичного терму

тип активної функції
приналежності

числові параметри
активної функції
приналежності

Це поле показує ім 'я та
тип активного
лінгвістичного терму

Область зміни активної
змінної

Область зміни активної
змінної, що
відображає ться на  екрані

 

Рисунок 2.2 – Вікно редактора функцій приналежності 

 

Для того, щоб ввести нову  функцію приналежності, необхідно вибрати в меню  

Edit→Add MFs... або Edit→Add custom MFs.... В першому  випадку  відкривається таке 

вікно: 

 

 

 

Рисунок 2.3 – Вікно параметрів стандартної функціі приналежності 
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В другому  випадку  відкривається таке вікно: 

 

 

Рисунок 2.4 – Вікно параметрів функціі приналежності користувача 

 

В цьому  вікні можна ввести будь-яке ім'я терму , тип та межі функції приналежності.  

Як видно із рис. 2.2, Fuzzy Logic Toolbox пропонує для системи інференції Мамдані 11 

типів функцій приналежності. Їх назви та стислий опис представлені в табл. 2.1. 

 

Таблиця 2.1 – Тип функцій приналежності лінгвістичних термів в Matlab 

 

Тип функції 
приналежності 

Опис Математичне визначення Графічне 
зображення 

dsigmf (a1,c1,a2,c2) різниця двох 
сигмоїдальних 
функцій 
приналежності 

)с(ха)с(ха 2211 е1

1

е1

1
−−−− +

−
+  

nmn 

gaussmf (σ, с) симетрична 
функція Гауса 

2

2с)(х

σ2е ⋅

−−

 

nmn 

gauss2mf 

(σ1,с1,σ2,с2) 

несиметрична 
крива, утворена 
двома 
функціями Гауса 

dxaякщо,

2
1σ2

2)1с(х

е ≤≤
⋅

−−

bxdякщо,
2

2
σ2

2)
2
с(х

е ≤≤
⋅

−−

 

nmn nmn 

 

 

a d b 
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Продовження табл. 2.1 

gbellmf (a,b,c) дзвіноподібна 
крива 

0b,

а

сх
1

1
2b

>
−

+

 

nmn nmn 

pimf (a,b,c,d) сплайнова крива, 
що проходить 
через точки a, b, 

c, d 

 
 

− 

a cb d

psigmf (a1,c1,a2, c2) добуток двох 
сигмоїдальних 
функцій 
приналежності 

)с(ха)с(ха 2211 е1

1

е1

1
−−−− +

⋅
+

 

nmn 

sigmf (a,c) сигмоїдальна 
функція 
приналежності 

с)а(хе1

1
−−+

 

nmn nmn 

smf (a,b) S-подібна 
сплайнова крива, 
що проходить 
через точки a, b 

 
 

− 

a b

trapmf (a,b,c,d) трапецієподібна 
функція 
приналежності 

dxcпри
dc

dx
cxbпри1

bxaпри
ab

ax
xdaxпри0

≤≤
−
−

≤≤

≤≤
−
−

≤∨<

 

a       b          c      d

 

trimf (a,b,c) трикутна 
функція 
приналежності 

dxmпри
dm

dx

mxaпри
am

ax
xdaxпри0

≤≤
−
−

≤≤
−
−

≤∨<
 

a         m      b

 

zmf (a,b) Z-подібна 
сплайнова крива, 
що проходить 
через точки a, b 

 
 

− 

a b

 



2 МОДЕЛЮВАННЯ СИСТЕМ ФАЗИ-РЕГУЛЮВАННЯ ЗА ДОПОМОГОЮ ПРОГРАМНОГО 
ПАКЕТА MATLAB/SIMULINK 

39

Для введення фази-правил використовується редактор правил. Щоб його відкрити,  

треба вибрати в меню View→Edit rules. Після цього відкривається вікно редактора правил  

(рис. 2.5). Складання фази-правил проводиться автоматично на основі опису  вхідних та  

вихідних лінгвістичних змінних, який був зроблений за допомогою редактора фази-блоків. 

Для того, щоб утворити нове правило, треба натиснути на кнопку  Add rule, після чого 

обрати значення кожної вхідної змінної, лог ічний зв'язок між вхідними змінними та значення  

вихідної змінної, що відповідає створеній ЯКЩО-частині фази-правила. У випадку , якщо 

правило не містить якоїсь вхідної величини, треба обрати як вхідну  величину  none. Якщо 

змінна має бути проінвертована, треба поставити прапорець напроти not.  

 

Вибір значень вхідних та
вихідних змінних

До цього  поля
автоматично
вводяться
правила

За допомогою цих кнопок Ви можете
ввести новіфази-правила та
відредагувати або видалити вже існуючи

Інвертуванняфази-
змінних  в правилах

Логічні зв'язки між
вхідними змінними

Це меню
використовується для
створення, відкриття,
збереження та
редагуванняфази-блоків

 

 

Рисунок 2.5 – Вікно введення фази-правил  

 

Діагностика розробленого фази-блока здійснюється за допомогою переглядача  

тривимірної функції (Surface Viewer) та переглядача правил (Rule Viewer). Для того, щоб 

викликати вікно переглядача правил, треба обрати в меню View→View rules, після чого на  

екрані з'явиться вікно: 
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Кожни й р ядок  графічно
представляє фази-правило

В ць ому  полі  Ви
можете точно
ввести числов і
значення

вхідних величин

Кожний стовпчик гр афіків  показує, як  вхідна або вихідна
змін на використову єть ся  в  правилі.  Зверху  показу єть ся

ім 'я  змінної  та ї ї  поточне числове зна чення

Результат
дефазифікації

Ці  кнопки дозволяють
пересуну ти графіки ліворуч ,

праворуч , вниз,  нагору

Пер есуваючи ці  лінії,  можна приблизно
встановити чи слов і значення  вхідних
змінних, для  я ких буде розр аховане
значення вихідно ї змінної

 

Рисунок 2.6 – Вікно тестування фази-правил  

 

Переглядач правил дає можливість для будь-якої комбінації числових значень вхідни х 

змінних (звичайно, із області зміни цих змінних!) визначити відповідне числове значення  

вихідної змінної.  

Переглядач тривимірної функції дає можливість представити залежність вихідної 

змінної від  вхідних змінних у  вигляді тривимірного графіка; особливо добре це  дозволяє 

проаналізувати фази-блоки, що мають дві вхідні та одну  вихідну  змінні. У випадку , якщо 

фази-блок має більш, ніж одну  вихідну  змінну , або більш, ніж дві вхідні змінні, можна  

обрати таку  комбінацію двох вхідних та однієї вихідної змінної, яка дозволяє найліпше  

представити передавальні властивості фази-блока. Для того, щоб викликати переглядач 

тривимірної функції, необхідно обрати в меню View→View surface, після чого  на  екрані 

з'явиться вікно: 
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Використовуйте  мишу ,
щоб повернути осі

В цих полях обираються  імена
зм інних, що  мають бути
представлені на  графіку

В цьому  полі
показуються ім ена
змінних, що не
відображаються на
тривим ірному  графіку

Натисніть тут у
випадку  необхідності
обновити графік

Область пре дста влення тривим ірного
графік залежності вихідної величини
від обраних вхідних величин

Це меню використовується для
створення, відкриття, редагування
та збереження фази-блоків

 

 
Рисунок 2.7 – Вікно переглядача тривимірного графіка передавальної функції 

фази-блока  
 

Для того, щоб дати користувачу  можливість переглянути установки фази-блока, що  

знаходиться в робочому  просторі Matlab, у  більш зручній формі, ніж  це  пропонує редактор 

фази-блоків, із можливістю копіювання інформації до буферу обміну  для подальшого 

редагування за допомогою інших програм, було розроблено ряд функцій виводу  на екран 

(System Display Functions). Огляд цих функцій представлений в табл. 2.2. 

 
Таблиця 2.2 – Функції виводу  на установок фази-блока екран 
 

Ім'я та параметри функції Опис функцій 

plotfis (fismat) Створює в вікні фігури діаграму  фази-блока, що 

міститься в робочому  просторі Matlab під ім'ям 

fismat. На діаграмі позначаються вхідні та вихідні 

змінні, вигляд їх термів, кількість фази-правил та  

тип системи інференції.  

plotmf (fismat,varType,varIndex) Виводить на екран графік функції приналежності 

лінгвістичної змінної фази-блока fismat. У списку  

параметрів вказуються тип змінної ('Input' або  

'Output') та її індекс.  
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Продовження табл. 2.2 

gensurf (fismat) Виводить на  екран тривимірний графік  

передавальної функції фази-блока fismat.  

getfis (fismat) Виводить на екран установки фази-блока fismat – 

тип фази-блока, к ількість вхідних та вихідних 

змінних, їх імена, тип дефазифікації, тип 

операторів інференції.  

 

Для того, щоб інтегрувати розроблений фази-блок до Simulink-моделі, що  має містити 

фази-регулятор , та промоделювати цю систему  регулювання, треба спочатку  переконатись,  

що фази-блок, створений за допомогою редактора фази-блоків, є збереженим до робочого 

простору  Matlab під іменем, яке використовується при параметризації Simulink-блока Fuzzy-

Logic-Controller. Для того, щоб зберегти фази-блок до робочого простору  Matlab, треба 

обрати в меню редактора фази-блоків File→Save to workspace або File→Save to workspace 

as. У випадку , якщо фази-блок був раніше спроектований та збережений на твердому  диску , 

цю операцію можна виконати безпосередньо в робочому просторі Matlab. Для цього в 

командному  рядку  необхідно набрати команду : 

fuz = readfis('Controller') 

fuz – ім'я FIS-матриці – матриці,  що відображує фази-блок у  робочому  просторі 

Matlab; 

Controller - ім'я файлу , який містить фази-блок.  

Після цього треба відкрити Simulink-бібліотеку  fuzblock. У результаті відкривається 

вікно: 

 

 

Рисунок 2.8 – Simulink-бібліотека фази-блоків 

З цієї бібліотеки до Simulink-моделі копіюється один із таких блоків: 
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� Fuzzy Logic Controller; 

� Fuzzy Controller with ruleviewer. 

Використання блока Fuzzy Controller with ruleviewer дає можливість у  процесі 

моделювання спостерігати за змінами вхідних та вихідних величин фази-блока за допомогою  

переглядача правил. 

Обраний блок необхідно параметризувати. Для цього треба двічі клацнути лівим 

клавішем миші на іконці блока. Якщо використовується блок Fuzzy Logic Controller, то 

після цього на екрані з'явиться вікно: 

Ім 'я фази-блока, який
Ви використовуєте в
моделі (ім'я FIS-
матриці, що
представляє його в
робочому просторі
Matlab)

 

 

Рисунок 2.9 – Вікно параметрів блока Fuzzy Logic Controller 

Блок Fuzzy Controller with ruleviewer має досить складну  структуру , яка 

представлена на рис. 2.10. 

Ім'я фази-блока в
робочому простор і

Matlab

 

Рисунок 2.10 – Структура блока Fuzzy Controller with ruleviewer 

Параметризація блока Fuzzy Controller with ruleviewer здійснюється, як показано на 

рис. 2.10. 
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3 ПРАКТИЧНЕ ЗАСТОСУВАННЯ ФАЗИ-ЛОГІКИ В СИСТЕМАХ 

РЕГУЛЮВАННЯ 

 

3.1 Постановка завдання  

 

Прикладом об'єкта практичного застосування фази-логіки в системах регулювання є 

електропривод із класу  низькошвидкісних слідкуючих приводів. Такі приводи мають низку  

характерних ознак : 

� велике значення передавального числа  в редукторі, яке може  сягати десятків та  

сотень, призводить до виникнення розбіжностей на виході редуктора; 

� масивна та відносно еластична механічна конструкція у  поєднанні з великим 

значенням передавального числа в редукторі робить можливою появу 

низькочастотних механічних коливань; 

� коефіцієнт моменту  пружності 

(3.1)                                                                                   

1
J

'
2J

1γ +=  

прагне досягти одиниці, тобто електродвигун досить слабко демпф ірує виникаючі 

механічні коливання. Затухання коливань здійснюється завдяки дії сил сухого 

тертя в механічній частині приводу . Слід зауважити, що  здатність системи до  

коливань зменшується із зростанням величини γ. Це ілюструє рис. 3.1, на якому 

наведені графіки перехідних процесів у  двомасовій системі електроприводу , що 

враховує наявність зазору в редукторі, при трьох значеннях коефіцієнту  моменту  

пружності. Найбільшу  схильність до коливань демонструє система з γ = 1.2, при  

γ = 10 перехідний процес носить аперіодичний характер . 
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Рисунок 3.1 – Відпрацьовування завдання на швидк ість двомасовою 

системою електроприводу 

Такі ознаки властиві цілій низці слідкуючих приводів у  широкому  діапазоні 

потужностей. До  цього класу  належать, наприклад,  електроприводи радіотелескопів, антен,  

сонячних печей. При складанні математичних моделей таких приводів досить часто потрібно  

враховувати вплив таких явищ, як зазор  у  редукторі, дія сил сухого  тертя, наявність  

еластичності механічного вала.  

Наявність еластичності притаманна багатьом типам передавальних ланцюгів – довгим 

валам, пружинам, пасовим передачам. Ці ланцюги мають еластичні й коливальні властивості,  

які не можна  ігнорувати. При наявності таких ланцюгів в механічній частині електроприводу 

при переносі моменту  виникає перекручування вала. Це явище призводить, з одного боку , до 

появи коливань, з іншого, до перевантаження передавальних пристроїв та самого  

електродвигуна. В системах регулювання положення будь-які коливання вихідної величини 

взагалі неприпустимі, тому  що ці системи мають здебільшого досить високі вимоги до  

точності.  

На рис. 3.2 наведене зображення моделі двомасової системи. Електродвигун та робоча 

машина поєднані між собою за допомогою еластичного вала.  

робоча машинадвигун

m ω1

еластичний вал

С
mO ω2

J1

dt

dω
J 1

1
dt

dω2
2

J2

 

Рисунок 3.2 – Двомасова система електроприводу 
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Припустимо, що маса вала дор івнює нулю. Рівняння  руху  системи має вигляд:  

(3.2)0m
dt

dω
J

dt

dω
Jm O

2
2

1
1 =−−−  

де J1 – сумарний момент інерції з боку  двигуна; 

J2 – сумарний момент інерції  з боку  робочої машини, приведений до швидкості  

двигуна; 

m – момент двигуна;  

mO – момент опору ; 

ω1 – швидкість  двигуна;  

ω2 – швидкість  робочої машини, приведена до швидкості двигуна.  

Еластичний вал з коефіцієнтом жорсткості С переносить  обертаючий момент m12 :  

(3.3)
dt

dω
Jm

dt

dω
Jm)αC(αm 2

2О
1

12112
+=−=−=  

Циклічна частота власних незатухаючих коливань  системи [3] : 

(3.4)
JJ

JJ
Cω

21

21
O ⋅

+
⋅=  

Досить часто при аналізі систем електроприводу  необхідно  враховувати вплив сил  

сухого тертя та залежного від швидкості моменту  демпфірування. Обертаючий момент  

сухого тертя визначається за формулою: 

(3.5)signωKM ТТ ⋅=  

де КТ – коефіцієнт сухого тертя. 

Момент демпфірування визначається за формулою: 

(3.6))ω(ωKM 21ДД −⋅=  

В деяких механічних передавальних ланцюгах досить часто спостерігаються зазори. 

При цьому  в динамічному  режимі не відбувається жорсткий перенос моменту  в межах кута 

±∆α. Результатом цього є те, що  при лінійній  зміні вхідної величини вихідна величина є  

нелінійною, внаслідок чого виникає часовий зсув фаз між вхідною та вихідною величинами  

та усталена помилка (рис. 3.3).  
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α1

α2

∆α ∆α

α1

α2

t

α

a) α2 = f(α1) b) α = f(t)
 

Рисунок 3.3 – Вплив зазорів 

 

Структурна схема механічної частини системи електроприводу , складена  згідно  з  

рівняннями (3.2), (3.3) з врахуванням дії моменту  сухого тертя (3.5), моменту  демпф ірування 

(3.6) та зазору  в редукторі наведена на рис. 3.4 [3]. 

Зважаючи на усі вказані особливості двомасової системи, слід зазначити,  що побудова  

класичних регуляторів для неї, які б враховували вплив нелінійностей, є досить складним 

завданням, яке не завжди має однозначне рішення. Методи фаззи-логіки, які засновані на  

обробці нечіткої інформації, дають при регулюванні значно кращі результати, особливо коли  

до контуру  регулювання входять також  і класичні регулятори, оптимізовані за  традиційними  

методами (модульний оптимум, симетричний оптимум, настроювання за мінімумом 

резонансного максимуму ), що дозволяє поєднати достоїнства класичної концепції 

регулювання та методів, які засновані на теорії штучного інтелекту . Треба зауважити, що  

фаззи-логіка в "чистому  вигляді" використовується зараз дуже обмежено, набагато  

перспективнішим є її поєднання із нейросітками, що  дозволяє створювати гнучкі системи  

регулювання, здатні до самонастроювання.  

 

p1J

1

p

1
C

p
2

J

1

p

1

кДp

MО

α2

сухе тертя

еластичний
вал

зазор

демпфірування

m12α1
m

сухе тертя

 

 

Рисунок 3.4 – Структурна схема механічної частини двомасової системи 

електроприводу 
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3.2 Лабораторний практикум 

 

Лабораторна робота 1. Використання неадаптивного фази-регулятора в системі 
автоматизації 

 

1 Постановка завдання  

Об'єктом дослідження є електропривід постійного струму , що приводить до руху 

робочу  машину  (параметри системи представлені в табл. 3.1).  

 

Таблиця 3.1 – Параметри системи, що підлягає дослідженню  
 

Найменування параметру Числове 

значення 

Одиниця 

виміру 

Номінальна потужність електродвигуна P 160 кВ 

Кількість пар  полюсів 2p 6 − 

Номінальний струм електродвигуна I 390 A 

Номінальна напруга електродвигуна U 440 В 

Номінальна частота обертання 

електродвигуна n 

 

980 

 

об/хв  

Величина опору  якірного ланцюга RЯ  0,025 Ом 

Момент інерції електродвигуна J1 58,7 кг⋅м2  

Стала двигуна k 4,18 В⋅с  

Стала часу  якірного ланцюга TЯ  82 мс  

Механічна стала часу  TM 84 мс  

Коефіцієнт підсилення перетворювача KП 68,35 В 

Стала часу  перетворювача TП 1,7 мс  

Коефіцієнт жорсткості вала С  2,06⋅10
5 Н⋅м 

Момент інерції робочої машини J2  29,35 кг⋅м2
 

 

Математична модель системи складається з урахуванням еластичних властивостей  

довгого вала, наявності зазору в редукторі та дії моменту  сил сухого тертя в двигуні та 

робочому механізмі. Система містить класичні регулятори струму , швидкості двигуна та 
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положення, які оптимізовані за модульним оптимумом (табл. 3.2). Структурна схема  

системи, що підлягає дослідженню, надається на рис. 3.6. 

Таблиця 3.2 – Розрахунок системи підпорядкованого регулювання положення  
 

Регулятор Розрахунок параметрів 

ПІ-регулятор  

струму 

0.025

1
68.350.00172

ЯR

1

ПKПT2СКΣT2OT

с0.082ЯTРСT

=⋅⋅⋅=⋅⋅⋅=⋅⋅=

==

 

П-регулятор  

швидкості 
2065

4.18

0.025
0.00342

0.084

к

ЯR

ΣШT2

MT

ШКΣШT2

MT

РШ
K =

⋅⋅

=

⋅⋅

=
⋅⋅

=  

П-регулятор  

положення 
73.529

10.00682

1

ПVΣПT2

1

РПK =
⋅⋅

=
⋅⋅

=  

 

Задане значення вихідної величини системи змінюється за лінійним законом.  

Система, що підлягає розгляду , має високі вимоги до точності, тому  що йдеться про 

регулювання положення, а будь-які коливання та усталена помилка в цьому  випадку  є 

неприпустимими. Класичні регулятори не здатні забезпечити задовільну  точність (рис. 3.5). 

Одним із засобів покращення передавальних властивостей системи є застосування фази-

регулятора. Пропонується використати неадаптивний фази-регулятор , що підключається 

паралельно до класичного регулятора положення (рис. 1.15). Така система регулювання є 

досить стабільною та дозволяє значно покращити вид перехідного процесу , отримавши на  

виході системи  майже експоненціальну  криву  вихідної величини –  кута повороту  робочого 

механізму . 

 

Рисунок 3.5 – Перехідні процеси в двомасовій системі електроприводу  

підпорядкованого регулювання з класичними регуляторами  
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2 Мета роботи 

Мета лабораторної роботи полягає в дослідженні системи електроприводу постійного  

струму  за допомогою програмного пакета M atlab/Simulink з метою порівняння 

передавальних властивостей системи з підпорядкованим регулюванням положення з 

класичними ПІ-регулятором струму і П-регуляторами швидкості і положення та системи з 

поєднанням класичного підпорядкованого регулювання і фази-корекції. 

 

3 Зміст роботи  

3.1 Дослідження системи електроприводу  з класичною структурою підпорядкованого 

регулювання: 

� запустити середовище програмування М atlab 5.2; 

� ввійти до програмного пакету  Simulink, набравши в командному  рядку  команду 

simulink; 

� додати директорію x:\...\alex до списку  активних директорій, для чого вибрати 

в меню  File→Set Path. Після цього відкриється вікно списку  активних 

директорій (Path Browser), в якому  слід вибрати в  меню Path→Add to Path та  

ввести шлях до директорії x:\...\alex; 

� відкрити в середовищі Simulink файл x:\... \alex\system.mdl; 

� ввести параметри системи, що підлягає дослідженню, до  робочого простору 

М atlab 5.2, для чого клацнути двічі лівим клавішем миші на блоці Enter 

Parameter. Встановлені параметри можна переглянути в робочому  просторі 

М atlab; 

� промоделювати систему , для чого в меню Simulink вибрати Simulation→Start; 

� проаналізувати результати моделювання, для чого клацнути двічі лівим 

клавішем миші на блоці Plot, який виконує функції виводу  на екран графіків 

величин,  що мають бути проаналізовані – завдання на положення, положення 

двигуна, положення робочого механізму , помилки регулювання й її похідної,  

швидкості двигуна та переданого через редуктор  моменту  m12. За допомогою  

графіків визначити величину  перерегулювання положення робочого механізму , 

інтервал зміни швидкості двигуна, помилки регулювання й її похідної; 

� зафіксувати результати моделювання. 
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3.2 Дослідження системи електроприводу  з класичною структурою підпорядкованого 

регулювання та паралельною фази-корекцією 

3.2.1 Розробка фази-регулятора 

Процес розробки фази-регулятора здійснюється за алгоритмом, розглянутим у  розділі 

1.3 (рис. 1.12). 

1. Проведення аналізу системи. Встановлення структури контуру регулювання та 

вхідних і вихідних величин фази-регулятора. 

Обирається одна з найбільш стабільних та простих для настроювання структур  – 

контур  з паралельною фази-корекцією, загальна структура якого представлена на рис. 1.15).  

Фази-регулятор підключається паралельно до класичного регулятора положення. Вхідними  

величинами фази-регулятора є помилка регулювання положення робочого механізму   

(αзав-α2) та похідна від неї (α зав-α2)'. Вихідною величиною фази-контролера є коригувальний 

сигнал,  який складається з вихідним сигналом традиційного пропорційного  регулятора 

положення. Сума цих сигналів утворює завдання на швидкість двигуна. 

2. Встановлення алгоритмічних ступенів свободи.  

Практика показує, що на етапі моделювання тип фази-інференції не грає великої ролі 

(це можна легко  перевірити, проекспериментувавши за допомогою редактора фази-блоків  

Fuzzy  Logic Toolbox). Вибір  операторів інференції має велике  значення лише при практичній  

реалізації фази-блока, тому  що він  визначає швидкодію контуру  регулювання та стабільність  

передавальних властивостей фази-блока. Проте рекомендується дотримуватись певних 

рекомендацій і використовувати загальноприйняті сполучення операторів окремих етапів  

інференції (табл. 1.7). Для проектованого фази-блока пропонується використати такі 

установки: 

� оператор  імплікації – мінімум-оператор ; 

� оператор  агрегації – максимум-оператор . 

Рекомендується використати найбільш популярний метод дефазифікації -  

гравітаційний (centroid).  

3 Встановлення параметричних ступенів свободи.  

Цей етап є центральним кроком процесу  розробки фази-регулятора, він складається з 

трьох кроків. 

3.1 Встановлення можливих інтервалів зміни вхідних та вихідних величин  

Результати моделювання системи з класичною системою регулювання дозволяють 

визначити інтервали зміни вхідних та вихідних величин. Помилка регулювання змінюється в 

інтервалі [-0.5,0.5], похідна від неї змінюється в інтервалі [-10,10]. Сумісний аналіз  кривих 
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зміни помилки регулювання, її похідної та швидкості двигуна дають можливість визначити  

інтервал зміни вихідної величини як [-100,100]. 

 

3.2 Встановлення форми та параметрів функцій приналежності 

Вхідним змінним Error (помилка регулювання) та D-Error (похідна помилки  

регулювання) відповідає п'ять лінгвістичних термів: 

� PL – Positive Large (позитивна велика) ; 

� Р – Positive (позитивна); 

� Z – Zero (нуль); 

� N – Negative (негативна); 

� NL – Negative Large (негативна велика).  

Форма граничних термів PL та NL приймається трапецієподібною (прямокутна 

трапеція, прямий кут якої відповідає точці на межі області визначення змінної).  Форма  

термів Р, Z, N приймається трикутною. Трикутна та трапецієподібна форми функцій 

приналежності вживаються в техніці регулювання найчастіше, тому  що це дозволяє 

зменшити витрати машинного часу . 

Границі термів були спочатку  встановлені приблизно в межах інтервалів зміни  

вхідних величин  та  визначені остаточно після моделювання системи.  Остаточно прийняті 

для лінгвістичних змінних Error та D-Error функції приналежності зображені на рис. 3.7 та 

рис. 3.8, а параметри їх термів представлені в табл. 3.3-3.4.  

 

 

 

Рисунок 3.7 – Функція приналежності вхідної змінної Error 
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Таблиця 3.3 – Параметри функції приналежності вхідної змінної Error 

 

Терм Форма 
терму 

Характерні точки 

NL (Negative Large)  трапеція  [-0.5, -0.5, -0.14, -0.07] 

N (Negative)  трикутник [-0.14, -0.07, 0] 

Z (Zero)  трикутник [-0.005, 0, 0.005] 

Р (Positive) трикутник [0, 0.07, 0.14] 

PL (Positive Large)  трапеція  [0.07, 0.14, 0.5, 0.5] 

 

 

 

Рисунок 3.8 – Функція приналежності вхідної змінної D-Error 

 

Таблиця 3.4 – Параметри функції приналежності вхідної змінної D-Error 

Терм Форма 
терму 

Характерні точки 

NL (Negative Large)  трапеція  [-10, -10, -2 -1] 

N (Negative)  трикутник [-2, –1, 0] 

Z (Zero)  трикутник [-0.25, 0, 0.25] 

Р (Positive) трикутник [0, 1, 2] 

PL (Positive Large)  трапеція  [1, 2, 10, 10] 

 

Вихідній змінній Korrektion (корекція) відповідає дев'ять лінгвістичних термів: 

� PL – Positive Large (позитивна велика) ; 

� PМ - Positive M iddle (позитивна середня); 

� PS  - Positive Small (позитивна маленька); 

� Р – Positive (позитивна); 

� Z – Zero (нуль); 
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� N – Negative (негативна); 

� NS  – Negative Small (негативна маленька); 

� NМ – Negative M iddle (негативна середня); 

� NL – Negative Large (негативна велика).  

Як і у  випадку  вхідних змінних, форма граничних термів PL та NL приймається  

трапецієподібною, а форма "внутрішніх" термів PМ, PS , Р, Z, N, NS, NМ - трикутною. 

Обрати параметри термів для вихідної змінної складніше, ніж для вхідних змінних, точно  

встановити їх можна  лише після багаторазового моделювання. Остаточно приймається 

функція приналежності, що зображена на рис. 3.9. Параметри функції приналежності 

лінгвістичної змінної Korrektion подаються в табл. 3.5. 

 

 

 

Рисунок 3.9 – Функція приналежності вихідної змінної Korrektion 

 

Таблиця 3.5 – Параметри функції приналежності вихідної змінної Korrektion 

 

Терм Форма терму  Характерні точки 

NL (Negative Large)  трапеція  [-8, -8, –5.61, –3.77] 

NМ (Negative M iddle)  трикутник [-5.6, -4, -2.4] 

NS  (Negative Small)  трикутник [-4, -2.4, -0.8] 

N (Negative)  трикутник [-2.38, -0.8, 0] 

Z (Zero)  трикутник [-0.8, 0, 0.8] 

Р (Positive) трикутник [0, 1.312, 2.624] 

PS  (Positive Small)  трикутник [1.39, 2.83, 4.05] 

PМ (Positive M iddle) трикутник [2.64, 3.97, 5.65] 

PL (Positive Large)  трапеція  [4.064, 5.44, 8, 8] 

3.3 Складання бази фази-правил 
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Правила складаються на основі інтуїтивних знань експерта. В нашому  випадку  як 

експертні знання використовуються результати аналізу  перехідних процесів, що були 

отримані при моделюванні системи з класичною системою регулювання. Деякі правила після  

моделювання системи з паралельною корекцією можуть бути уточненими.  

Принцип складання фази-правил ілюструється за допомогою рис. 3.10, на якому 

представлений перехідний процес у  системі з класичним регулятором. Як зазначалося вище, 

завдання паралельної фази-корекції полягає в покращенні вигляду  перехідного процесу , 

зменшенні величини перерегулювання в ідеальному  випадку  до нуля. Тому  найбільш 

небажаною є ділянка перехідного процесу , коли величина кута повороту перевищує 

величину  завдання на кут повороту . На рис. 3.10 виділена саме ця ділянка та  наведені у  

масштабі збільшення відповідні фрагменти кривих зміни помилки регулювання, її похідної 

та швидкості двигуна.  

Розглянемо точки 1, 2, 3. В точці 1 помилка регулювання позитивна, а її похідна  

негативна велика. Це означає, що помилка регулювання має тенденцію до зменшення, тому  

корекція має бути незначна.  Знак  корекції +, тому  що із кривої швидкості двигуна видно,  що  

поблизу  точки 1 швидкість зменшується, тобто рух сповільнюється, а його треба прискорити,  

щоб зменшити величину  помилки. Отримуємо таке правило: 

ЯКЩО Помилка регулювання Позитивна І Похідна помилки регулювання Негативна 

Велика, ТО Корекція Позитивна. 

В точці 2 помилка регулювання негативна  та  має досить велике числове значення, а  її 

похідна майже дорівнює нуля, тобто помилка регулювання поблизу  точки 2 змінюється 

незначно. Це означає, що корекція не має бути досить сильною. Знак корекції визначимо,  

проаналізувавши графік швидкості двигуна. Поблизу  точки 2 швидкість двигуна негативна,  

тому  для компенсації корекція має бути позитивною – Р. Таким чином, отримуємо правило: 

ЯКЩО Помилка регулювання Негативна І Похідна помилки регулювання Нульова,  

ТО Корекція Позитивна. 

В точці 3 помилка регулювання позитивна, а її похідна позитивна та має досить  

велике числове значення, тобто поблизу  точки 3 помилка регулювання має тенденцію до  

подальшого зростання. Виходячи з цього, можна стверджувати, що корекція має бути  

негативною з метою  обмеження швидкості.  Аналіз  кривої швидкості показує, що величина  

цієї корекції не  має бути дуже  великою, тому  що швидкість на  цій ділянці вже  є негативною  

і, надмірно її знизивши, можна отримати велике значення перерегулювання. Таким чином 

отримуємо два правила: 
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ЯКЩО Помилка регулювання Позитивна І Похідна помилки регулювання Позитивна, 

ТО Корекція Негативна Маленька. 

 

ЯКЩО Помилка регулювання Позитивна І Похідна помилки регулювання Позитивна 

Велика, ТО Корекція Негативна Середня. 

Складені таким чином та уточнені після моделювання правила наведені в табл. 3.6.  
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Рисунок 3.10 – Перехідні процеси в двомасовій системі електроприводу  постійного 

струму 
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Таблиця 3.6 – Фази правила 
 

Error 

D
-E

rr
o

r
 

PL P Z N NL 

PL NL NM Z N Z 

P NM NS Z Z P 

Z PM PS Z P PS 

N N Z Z PS PM 

NL Z P Z PM PL 

 
3.2.2 Моделювання системи електроприводу з класичною системою  

підпорядкованого регулювання та паралельною фази-корекцією: 

� створити за допомогою  Fuzzy  Logic Toolbox фаззи-блок з  параметрами,  що  

наведені в пункті 3.2.1. Утворену  FIS-матрицю зберегти на жорсткий диск  

та в робочий простір  M atlab; 

� вставити  до Simulink-моделі,  що міститься в файлі x:\...\alex\system.mdl, 

паралельно до пропорційного регулятора положення фази-блок (Fuzzy 

Logic Controller або Fuzzy Controller with ruleviewer). Запараметрувати 

цей блок; 

� зберегти на жорсткий диск створену  Simulink-модель під іменем 

system1.mdl; 

� промоделювати систему ; 

� за допомогою блока  Plot вивести на  екран графіки завдання на положення,  

положення двигуна, положення робочого механізму , помилки регулювання 

та її похідної, швидкості двигуна й переданого через редуктор  моменту  

m12; 

� зафіксувати результати моделювання; 

� порівняти результати, що були отримані в першій частині лабораторної 

роботи, з результатами  моделювання системи  з паралельною фази-

корекцією, зробити висновки.  

 

 

 



3 ПРАКТИЧНЕ ЗАСТОСУВАННЯ ФАЗИ-ЛОГІКИ В СИСТЕМАХ РЕГУЛЮВАННЯ  59

4 Зміст звіту 

В звіті повинні бути представленими: 

� структурна схема системи, що підлягала дослідженню; 

� параметри фази-регулятора для паралельної корекції – функції приналежності 

лінгвістичних змінних, фази-правила, тривимірній  графік передавальної функції 

фази-блока; 

� графіки зміни завдання на положення, положення двигуна, положення робочого 

механізму , помилки  регулювання й її похідної,  швидкості двигуна та  переданого  

через редуктор  моменту  m12 для системи  електроприводу  з класичною  

підпорядкованою системою регулювання та для системи з  паралельною фази-

корекцією; 

� аналіз результатів. 

 

Лабораторна робота 2. Адаптація фази-логіки в системах регулювання 

 

1 Постановка завдання  

Розглянута в попередній лабораторній роботі система регулювання з 

неадаптивним фази-регулятором має декілька недоліків. Насамперед це її негнучкість  та  

відсутність особливої точності. Це є її основною вадою, яка зумовлює неможливість  

використання фази-систем у  “чистому  вигляді” для виконання такого, наприклад,  

завдання, як точне позиціювання.  

 Щоб зробити фази-систему  більш досконалою, було запропоновано об’єднати її з  

іншими  формами штучного інтелекту , які дозволяють зробити систему  фази-регулювання 

більш гнучкою. В цій роботі підлягає розгляду  подібне об’єднання фази-системи з  

нейросітками [9], а точніше з алгоритмами навчання та тренування нейросіток.  

Об’єктом досліджень є система електроприводу  підпорядкованого регулювання 

швидкості.  Як і в попередній  роботі, з метою покращення якості роботи в систему  вводиться 

паралельна фази-корекція, що зумовлена необхідністю демпфірування внутрішніх коливань  

в системі. Проте така система має невелику  швидкодію, особливо коли йдеться про 

відпрацьовування стрибкоподібного  завдання. Причиною є класичний ПІ-регулятор 

швидкості, який настроюється таким чином, щоб забезпечити аперіодичний перехідний  

процес в лінійній системі. Система відпрацьовує завдання без коливань, проте потребує 

багато часу , що не є бажаним в слідкуючих системах. З  метою виправлення цього недоліку  в 
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систему  вводяться 2 пропорційноінтегральні фази-регулятори, що здійснюють адаптацію  

класичного ПІ-регулятора швидкості. Один із них є неадаптивним фази-регулятором 

(регулятор  сталої часу ), а інший (фази-регулятор  коефіцієнту  підсилення) має спроможність  

до самоадаптації. Причиною того, що фази-регулятор  сталої часу  не потребує адаптації,  є те,  

що зміна сталої часу  пропорційноінтегрального регулятора у  відносно малих межах 

несуттєво впливає на процес регулювання, тому  цим впливом можна знехтувати.  

Для адаптивного регулятора сталої часу  використовується непряма стратегія  

адаптації, що  ґрунтується на моделі процесу  (рис. 1.18). Як модель процесу  виступає  цільова  

функція, яку  необхідно отримати на виході системи після певної кількості тренувань 

системи.  

Структурна схема системи регулювання, що підлягає дослідженню, надається на  

рис. 3.11. 

фази-р егулятор
коефіцієнту
підсилення

фази-р егулятор
сталої часу

паралельна
фази-корекція

×

×

об'єкт
р егу лювання

цільова фу нкція

 

 

Рисунок 3.11 – Структурна схема контуру  регулювання системи електроприводу  з 

адаптивним класичним ПІ-регулятором та паралельною фази-

корекцією 

 

2 Мета роботи 

Мета лабораторної роботи полягає в дослідженні системи електроприводу постійного  

струму  за допомогою програмного пакета M atlab/Simulink з метою порівняння ефективності 

використання двох різних алгоритмів навчання нейросіток (методу  Відроу – Хоффа та 

методу  Кохонена) для адаптації фази-регуляторів в системах регулювання електроприводів. 
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3 Теоретична частина 

3.1 Основи теорії нейросіток  

3.1.1 Біологічна та математична моделі нейрона  

Нейросітки - це системи, що використовують деякі з відомих принципів організації 

людського мозку  і базуються на біологічних моделях [7]. Докладний розгляд цих біологічних 

моделей дозволяє порівняти мозок людини або високо розвиненої тварини з комп'ютером.  

Найважливішим результатом такого порівняння є висновки відносно паралельної структури 

як першого, так і останнього, бо це робить можливим здійснювати у  комп'ютері імітацію  

роботи біологічних нервових систем,  а  це,  в свою чергу , дозволяє надати  комп’ютеру  таку 

властивість, як спроможність до навчання. 

Першою спроможною до навчання нейросіткою був перцептрон, який базувався на 

аспектах відпрацьовування та збереження інформації. За допомогою правил навчання після  

певної кількості тренувань перцептрон ставив у  відповідність вхідним величинам бажані 

вихідні. Проте ця нейросітка не була спроможна вирішувати більш важливі проблеми, що  

спонукало до розробки нових більш потужних нейросіток та пошуку  нових правил навчання. 

 У  протиріччя до біології або до нейрології для нейрона не використовується модель, 

яка чітко описує всі його аспекти, а тільки та модель, що сама по собі є дуже грубим 

узагальненням [10]. Традиційна модель нейрона, яка представлена на рис. 3.12,  

розглядається тут як різновид суматора з граничним значенням на його виході.  

Біологічний нейрон складається з тіла нейрона, до якого входить велика кількість 

дендритів (від 10000 до 100000) і виходить тільки один аксон. Якщо сума вхідних сигналів  

перевищує певну  межу  (у  випадку  біологічного нейрона - граничний потенціал), то нейрон 

активізується і посилає через вихідний провідник (аксон) короткочасний електричний  

імпульс до інших нейронів [11]. Таким чином, нейрон являє собою процесор  з єдиною  

спроможністю - посилати електричні імпульси залежно від суми вхідних сигналів. 
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Рисунок 3.12 - Біологічна та математична моделі нейрона  

 

Між входом одного нейрона (дендритом) та виходом попереднього (аксоном) є  ще  

одна клітина,  яка може  підсилювати або подавляти сигнал, який до неї надходить. Ця клітина  

називається сінапс і знаходиться найчастіше просто на  тілі нейрона. Для процесу  навчання  

сінапс має дуже велике значення, тому  що з часом він може змінювати свою властивість  

підсилювати або подавляти сигнал.  

Комунікація між нейронами завжди відбувається тільки в такому  напрямку : 

Сінапс → Дендрит → Тіло нейрона → Аксон → Сінапс і т. д.  

Штучний нейрон можна представити як процесор , який приймає тільки два  стани -  

активний та пасивний.  Тому  відповідно до бінарної логіки надамо активному  стану  значення  

1, а пасивному  стану  значення 0. Вхідними сигналами нейрона є імпульси, що передаються 

через дендрити, які, в свою чергу , є виходами інших нейронів. Проте перед тим, як досягти  

тіла нейрона, вхідні сигнали проходять через сінапси. Цього можна легко досягти шляхом 

множення вхідних сигналів на позитивне (ефект підсилення) або  негативне (ефект  

ослаблення) число. Ці числа отримали назву  вагових коефіцієнтів. 

Сигнал  на  виході нейрона з’являється тільки тоді, коли сума  всіх вхідних сигналів 

перевищує певне граничне значення. При побудові моделі нейрона це досягається шляхом 

порівняння суми множення всіх вхідних сигналів на величини сінапсів або, що одне й те  

саме, на відповідні вагові коефіцієнти з граничним значенням. Якщо сума більша, ніж  

граничне значення, то на виході нейрона буде встановлено одиницю, а якщо ні - то нуль. 

Наочно модель нейрона представлена на рис. 3.13.  



3 ПРАКТИЧНЕ ЗАСТОСУВАННЯ ФАЗИ-ЛОГІКИ В СИСТЕМАХ РЕГУЛЮВАННЯ  63

 

Рисунок 3.13 - Функціональна модель нейрона  

Для урахування граничного значення при підсумовуванні вхідних сигналів 

вводиться допоміжний вхід В – біас.  

Вхідні сигнали Х1,…Хn та В) проходять через вагові коефіцієнти W(1,1),…W(1, n+1), 

підсумовуються і проходять через передавальну  функцію F на вихід. Вхідне значення біасу  

завжди дорівнює одиниці.  

Виходячи із схеми рис. 3.13, значення на виході суматора розраховується за 

формулою: 

(3.7))  w B -  w  x(  x)Z(w,
n

1  i

1  i , 1i , 1i∑
=

+⋅⋅=  

Ця функція називається функцією активності [7].  

Значення на виході нейрона є функцією від функції активності: 

(3.8)Z)x,F(w,  F(Z)  Y ==  

Як передавальна функція може бути використана одна із стандартних функцій або  

будь-яка інша, на розсуд проектувальника нейросітки.  

 

3.1.2 Нейросітка 

Для того, щоб отримати найпростішу  нейросітку , треба об’єднати між  собою декілька  

нейронів. На рис. 3.14 представлена нейросітка з двома нейронами, яка має три входи (Х1, Х2  

та В) та два виходи (Υ1 та Υ2).  
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.  

Рисунок 3.14 - Схема нейросітки  

Щодо параметрів нейронів, з яких будується нейросітка, немає жодних усталених 

законів або правил. Наприклад, передавальні функції нейронів можуть бути однакові за  

своїм виглядом та параметрами або відрізнятися одна від одної.  Це стосується також і 

зв’язків між нейронами, що є дуже актуальним при розгляді багатошарових нейросіток. 

 

3.1.3 Правила навчання і тренування нейросіток  

Найважливішою складовою частиною моделі нейросітки є процес навчання. Метою 

процесу  навчання є  визначення таких вагових коефіцієнтів W(1,1),…W(1, n+1), при яких сітка  

буде реагувати заданими вихідними  значеннями на задані вхідні значення. Щоб досягати  

цього, необхідно на кожному  етапі тренування порівнювати дійсне вихідне значення  

нейросітки з бажаним і на підставі цього змінювати вагові коефіцієнти таким чином, щоб на  

подальших етапах тренування дійсне та бажане вихідне значення сходилися [10].  

Існує велика кількість правил тренування нейросіток, саме  від них залежить  

швидкість та точність навчання, звичайно, з а інших рівних умов. Тому  виникає проблема  

пошуку  оптимального правила навчання, яке б задовольняло вимогам швидкості та точності 

процесу  навчання.  

Одним з алгоритмів навчання є  перцептрон. Правило перцептрон відповідає  ∆-

правилу  або правилу  Відроу -Хоффа і має такий математичний опис: 

 (3.9)                                       ),y (a x+ ww
iij

1 -k 
ji,

k
ji,

−⋅=  

де w
k
i,j,w

k-1
i,j − нове і попереднє значення вагових коефіцієнтів;  

хj − вхідний сигнал ;  

аi − бажаний вихідний сигнал; 

уi − дійсний вихідний сигнал.  
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Інші правила є більш досконалими, вони містять в собі параметр  швидкості 

навчання або коефіцієнт навчання і належать до так званого другого покоління 

правил тренування. Одним з цих правил є правило Відроу  - Хоффа, яке має такий  

вигляд: 

(3.10)                                           )y (axlr + ww iij
1 -k 

ji,
k

ji, −⋅⋅=  

де lr - коефіцієнт навчання. 

Другий клас алгоритмів навчання містить низку  правил, що мають спроможність до 

самоадаптації. Найвідомішим з них є правило Кохонена: 

(3.11)                                          ) w- (xlr + ww 1 -k 
ji,j

1 -k 
ji,

k
ji, ⋅=  

 

3.3 Адаптація фаззи-логіки в системах регулювання 

Метою об’єднання фаззи-логіки з іншими формами штучного інтелекту  є 

удосконалення фаззи-логіки. В цій роботі розглядається об’єднання фаззи-системи з  

алгоритмами навчання та тренування нейросіток.  

 Як зазначалося при розгляді теоретичних основ фаззи-регулювання, форма термів 

вхідної фаззи-змінної,  площа термів вихідної фаззи-змінної та значення діапазонів зміни цих 

змінних визначаються спеціал істом, виходячи з його досвіду  та знань в галузі, де 

застосовується фаззи-система. Але спеціал іст - це людина, а людині властиво помилятись.  

Тому  необхідно ввести певну  корекцію вихідного значення фаззи-регулятора у  вигляді 

змінних коефіцієнтів, щоб не змінювати в процесі роботи самі лінгвістичні правила.  

 Формула розрахунку  вихідного значення фаззи-регулятора має такий вигляд: 

(3.12)                                       , 
....  µ  µ

...   W X  µ   W X  µ
  X

21

2E21D1
S ++

+⋅⋅+⋅⋅
=  

де W1, W2 - корегувальні коефіцієнти.  

Пропонується змінювати  коригувальні коефіцієнти за  правилами тренування  

нейросіток. При застосуванні, наприклад, алгоритму  навчання Відроу -Хоффа коригувальні 

коефіцієнти вихідного значення фаззи-регулятора розраховуються за формулою: 

(3.13)                             ) х(хxlr + ww цільзав
1 -k 

ji,
k

ji, −⋅⋅=  

де Хзав − завдання на вході системи регулювання; 

Хціль  − цільовий процес; 

Х − дійсний процес на виході системи (рис. 3.15).  
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Рисунок 3.15 - Структурна схема адаптивної фази-системи електропривода 

 

Результати роботи адаптивної системи можна оцінити за допомогою рис. 3.16.  

1 - Вхідна дія; 2 - Цільовий процес; 

3 - Ненавчена система  

1 - Вхідна дія; 2 - Цільовий процес; 

3 - П’ята епоха тренування коефіцієнту  

підсилення (навчена система)  

 

Рисунок 3.16 – Перехідні процеси в системі електроприводу  з адаптивною системою 

регулювання 

Запропонована  методика  самоадаптації фаззи-регулятора в системах регулювання є  

дуже ефективною в тому  плані, що дозволяє автоматично коригувати всі недоліки і вади,  

зроблені при проектуванні тієї чи іншої фази–системи, не  змінюючи самої фази–системи.  

Слід також додати, що завдяки об’єднанню алгоритмів навчання нейросіток і фази–лог іки  

остання стала більш досконалою і набула суттєвого значення для вирішення широкого 

спектру  проблем в електроприводі на рівні з іншими формами штучного інтелекту . 
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4 Зміст роботи  

4.1 Дослідження ненавченої системи регулювання: 

� запустити середовище програмування М atlab 5.2; 

� ввійти до програмного пакету  Simulink, набравши в командному  рядку  команду 

simulink; 

� перейти до директорії (x:\...\Kollarov) командним шляхом, набравши в 

командному  рядку : 

>cd x:\...\Kollarov; 

� відкрити в середовищі М atlab файл x:\...\Kollarov\Gain.m. Впевнитись, що 

перед відповідними  рядками файла Gain.m, які наведені далі,  стоять коментарі 

" %  ": 

% w_KPI(pg,qg) = w_KPI(pg,qg) + LR_KPI * u(1) * u(4); 

% w_KPI(pg,qg) = w_KPI(pg,qg) + LR_KPI * (u(1)-w_KPI(pg,qg)); 

� ввести параметри регуляторів та всі інші дані, які знаходяться у  файлі daten.m, 

в середовище М atlab 5.2; 

� виконати одноразове моделювання системи і зафіксувати результати. 

4.2 Дослідження правила навчання Відроу  - Хоффа: 

� ввести параметри регуляторів та всі інші дані, які знаходяться у  файлі daten.m, 

в середовище М atlab 5.2; 

� змінити рядки файла Gain.m 

% w_KPI(pg,qg) = w_KPI(pg,qg) + LR_KPI * u(1) * u(4); 

% w_KPI(pg,qg) = w_KPI(pg,qg) + LR_KPI * (u(1)-w_KPI(pg,qg)); 

на рядки 

w_KPI(pg,qg) = w_KPI(pg,qg) + LR_KPI * u(1) * u(4); 

% w_KPI(pg,qg) = w_KPI(pg,qg) + LR_KPI * (u(1)-w_KPI(pg,qg)); 

� виконати послідовно чотири епохи тренування системи шляхом 

чотирикратного запуску  моделювання, зберігаючи результати після першого та  

четвертого моделювання; 

4.3 Дослідження правила навчання Кохонена: 

� ввести параметри регуляторів та всі інші дані, які знаходяться у  файлі daten.m, 

в середовище М atlab 5.2; 

� змінити рядки файла Gain.m: 

w_KPI(pg,qg) = w_KPI(pg,qg) + LR_KPI * u(1) * u(4); 

% w_KPI(pg,qg) = w_KPI(pg,qg) + LR_KPI * (u(1)-w_KPI(pg,qg)); 
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на рядки: 

% w_KPI(pg,qg) = w_KPI(pg,qg) + LR_KPI * u(1) * u(4); 

w_KPI(pg,qg) = w_KPI(pg,qg) + LR_KPI * (u(1)-w_KPI(pg,qg)); 

� виконати  послідовно десять епох тренування системи шляхом десятикратного  

запуску моделювання, зберігаючи результати після першого, четвертого та 

десятого моделювання.  

 

5 Зміст звіту 

В звіті повинні бути представленими: 

� графік перехідного процесу  в ненавченій системі, графік вхідної дії та  

цільового процесу  на одному  рисунку ; 

� графік перехідного  процесу  при першій та четвертій епохах тренування за 

правилом Відроу -Хоффа на одному  рисунку  з вхідною дією; 

� графік перехідного процесу  при першій, четвертій та десятій епохах 

тренування за правилом Кохонена на одному  рисунку  з вхідною дією; 

� порівняльні висновки ефективності використання цих двох алгоритмів  

навчання нейросіток для адаптації фази-регуляторів у  системах регулювання 

електроприводів у  плані швидкості і точності адаптації.  
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